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1. What's new in Teamcenter Easy Plan for
administrators
What's new in Teamcenter Easy Plan 2412 Deployment

Easy Plan 2412 delivers new features and enhancements. There are also certain issues and workarounds.

Installation

The Teamcenter Easy Plan kit is fully merged into the Teamcenter installation kit. Changes to the
installation include:

• The Easy Plan war file is deprecated.

Starting with version 6.2, Easy Plan fully migrated to Active Workspace and its installation. You no
longer need to configure the EasyPlan.war file during Easy Plan installations or updates.

• Easy Plan no longer uses workspaces.

Starting with version 6.2, you can use preferences, groups, and roles to grant users access to Easy
Plan solutions.

• Easy Plan is installed in a single pass during the Teamcenter installation.

• Easy Plan compatibility matches Active Workspace compatibility.

Caution
If you use work instructions authoring, you must install the Teamcenter database with UTF-8 encoding.
If you install any other encoding, garbage characters display in the Work Instructions pane within Easy
Plan and in Electronic Work Instructions.

General enhancements

• To define locations and revision rules specific to an integrated plant BOM, you must set up integrated
plant BOM prerequisites.

• When a text library object changes, you can now use the epw_update_stx_elements utility to find and
update HTML preview datasets attached to process or operation revisions.

• Using the EP_AllowDropResourceOnTarget preference, you can now allow Easy Plan users to
populate resources at the process station level and define the object types onto which users can
drag resources.

• Using the MESetPhysicalAttachmentInContextOfCommonParent preference, you can now define
how mount and attach relations are stored at the robot package level during cloning.

What's new in Teamcenter Easy Plan 2412 Deployment
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• Using the TCMA_EnableVariantOnStudyManager preference, you can now enable the variants
feature in Study Manager.

• Using the EP_CreateSubtypesForType_Mfg0ProcResource preference, you can now create a cobot as
a process resource.

• Using the EP_LineBalancingUseBottleneckTime preference, you can now define whether process
resource utilization is displayed in takt time or in bottleneck mode. The default value for this
preference is false. Set this preference to true to display utilization in bottleneck mode.

• Using the EP_LineBalancingProcessResourcesTypesForOverview preference, you can now define the
process resource types are displayed in the Overview tab. You can set the following values for this
preference:

◦ Cobot

◦ Human

◦ Machine

• Using the EP_LineBalancingProcessResourcesTypesForUtilization preference, you can now define
which process resource types are in the utilization list. The end user can then add a value range for
each process resource type. You can set the following values this preference:

◦ Cobot

◦ Human

◦ Machine

• Using the EP_LineBalancingDashboardInformation preference, you can now define which
information tiles display on the Line Balancing page dashboard.

• Using the EP_LineBalancingProductVariantsFilterValues preference, you can now control whether to
show the Weighted and Maximum product variants in the Line Balancing Product Variant list. The
default values for this preference are WEIGHTED:true and MAXIMUM:true. To hide the Weighted and
Maximum variants, set the preference values to WEIGHTED:false and MAXIMUM:false.

• Using the EP_LineBalancingCycleTimeIgnoreExternal preference, you can now define whether to
ignore or include external operations when cycle time is computed during line balancing. The
default for this preference is false, which means that external operations are included when cycle time
is computed. Set this value to true to ignore external operations when computing cycle time.

• Using the EP_LineBalancingProcessResourceTypesForTotalWaitTime preference, you can now
calculate the total wait time for all process resource types in the preference value. The default
value for this preference is human. This preference has the following valid values:

◦ Cobot

◦ Human

• Using the EP_ProcessPlanningViewModeForRoleME preference, you can now define role
configuration for the Process Planning page. The default value for this preference is false, which
configures the page for industrial engineers. Set the preference value to true to configure the page for
manufacturing engineers.

What's new in Teamcenter Easy Plan 2412 Deployment
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• Using the EP_TaktTimeForProductionProgramDefinition preference, you can now define whether
to display the takt time based on the production line, or based on the product variant in the
production program definition. The default value for this preference is Line. To display the takt time
based on the product variant, set the default value for this preference to ProductionProgramDefinition.

• Using the EP_ShowCloneIndication preference, you can now identify the source of cloned objects so
that changes are propagated with a full traceability view during cloning.

• Using the EP_hasMixedProductionWPAuthoringPermissions preference, you can now author work
package content that supports a mixed production solution.

• Using the EP_OperationPageActivitiesTabActivitiesGridAreaColumnConfiguration preference, you
can now customize the column configuration of the Time Management panel.

• Using the EP_TimeStudiesTableColumnConfiguration preference, you can now customize the
column configuration of the Time Study table in the Process Planning page.

• Using the EP_TimeStudyTreeColumnConfiguration preference, you can now customize the time
study tree in the Time Study page.

• Using the EP_TimeStudyPlantBopColumnConfiguration preference, you can now customize the
column configuration of the plant BOP tree in the Time Study page.

• Using the Mfg0MEPlantBOP.Mfg0TimeStudy.CopyPasteTemplate preference, you can now control
what data is created in a time study.

• Using the IsolatedStudySyncPublish preference, you can now control the closure rule that is used to
publish study objects.

• Using the StudyPlanningTimeBasedPublishRule preference, you can now control the information
that is published from the planning time study to the plant bill of process (BOP).

• Using the TC_CLONE_CREATE_BASED_ON preference, you can now define how the Based On relation
is created between masters and clones. For clones with this specific relation, propagation is
enabled.

Teamcenter Manufacturing Access configuration

Before you can use Teamcenter Manufacturing Access, you must configure the correct hosting preferences
for your environment.

Note
Starting in version 6.2, the ActiveWorkspaceHosting.PS.URL is deprecated.

If you use the ActiveWorkspaceHosting.PS.URL preference, end users cannot connect to NX or use the
MFG Search in Process Simulate.

What's new in Teamcenter Easy Plan 2412 Deployment
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Study Manager hosting preferences

To connect to Study Manager
(Teamcenter Manufacturing
Access) from...

Configure this hosting
preference

Additional information (if
applicable)

Teamcenter rich client TCMAccessHosting.RAC.URL For a server named hostname
on port 3000, type: http://
localhost:3000.

Process Simulate and NX TCMAHosting.PS.URL The format for
this preference is http://
<serverhost>:<gatewayport>.

Plant Simulation ActiveWorkspaceHosting.PLAN
T.URL

What's new in Teamcenter Easy Plan 2412 Deployment
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2. What is Teamcenter Easy Plan Deployment?
The installation and configuration information for all Teamcenter Easy Plan solution workspaces and
components is contained in a single deployment deliverable.

• Common installation steps for all workspaces and components using Teamcenter Environment Manager
(TEM).

• Workspace-specific and component-specific installation steps using TEM.

• Common installation steps for all workspaces and components using the Deployment Center.

• Workspace-specific and component-specific installation steps using the Deployment Center.

• Configuration information specific to each workspace and component.
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3. Installing with Teamcenter Environment
Manager
Teamcenter Environment Manager installation overview

Teamcenter Easy Plan is a solution that contains several workspaces and generic components. You
can install everything, or you can install just what your end users need. This documentation provides
installation instructions for everything in the Teamcenter Easy Plan and Electronic Work Instructions
solution. In places where information is workspace-specific or component-specific, instruction options are
presented in a table format, to indicate which options you should select.

Key installation tasks

1. Add Teamcenter Easy Plan to an installation.

2. If you are installing Teamcenter Easy Plan, test the connection to the Teamcenter database.

3. If you are installing Teamcenter Easy Plan, configure common options, and then configure options
for workspaces that you installed.

Add Teamcenter components to an Active Workspace installation

Beginning with version 6.2, Teamcenter Easy Plan, Electronic Work Instructions, and Next Generation
Planning are fully integrated with the Active Workspace installation kit. You do not need to perform any
extra steps to install these products.

You perform the installation on Teamcenter Environment Manager (TEM) in stages.

• Use TEM to copy data into the environment.

• Select and install the features you need in your environment.

Note
Teamcenter Environment Manager (TEM) is deprecated and will be obsolete in a future version
of Teamcenter. We recommend using Deployment Center to install Easy Plan or Electronic Work
Instructions. For further information, please see the following Active Workspace documentation:

• Installing Teamcenter using TEM (Linux)

• Installing Teamcenter using TEM (Windows)

• Installing Teamcenter Using Deployment Center

Teamcenter Environment Manager installation overview
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Use TEM to copy data into the environment

Perform this procedure first, to copy data from the Active Workspace kit into the correct locations in an
environment.

Procedure

1. Open the operating system Services dialog box, and stop all Teamcenter services except the
Teamcenter FSC Service.

2. In the operating system Services dialog box, verify that these services have a status of Started.

• Teamcenter Process Manager—this service is only listed if you installed the Microservice
Framework kit.

• OracleOraDb11g_home2TNSListener

• OracleServiceGEOLUSDB

• OracleServiceTC

3. To install Easy Plan or Electronic Work Instructions, download the Active Workspace kit file from the
Support Center to your Active Workspace server.

• Tc2412_wntx64.zip

• Tc2412_lnx64.zip

4. To install Easy Plan or Electronic Work Instructions on the Active Workspace server, unzip the
downloaded ZIP file to a temporary folder, such as C:\temp.

The location where you unzip the file is your kit_location.

5. On the Active Workspace server, choose Start → All Programs →Teamcenter → Environment
Manager.

6. In the Maintenance panel of the Teamcenter Environment Manager dialog box, click Updates
Manager and then click Next.

7. In the Update kit location field, browse to the Active Workspace kit location and click Open.

8. Click Next and follow the instructions to complete this part of the installation.

When you complete the update, click Close.

Select and install features

Now use Teamcenter Environment Manager to select features to install.

Use TEM to copy data into the environment
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Procedure

1. On the Active Workspace server, choose Start → All Programs → Teamcenter → Environment
Manager.

2. In the Maintenance panel of the Teamcenter Environment Manager dialog box, click
Configuration Manager and then click Next.

3. In the Configuration Maintenance panel, click Perform maintenance on an existing configuration
and then click Next.

4. In the Feature Maintenance panel, click Add/Remove Features and then click Next.

5. In the Features panel, browse through the list and expand Extensions.

6. In the Features panel, expand Active Workspace Server.

When you select a workspace or component, the TEM automatically selects all dependencies for that
workspace.

See Full features list for a detailed list of available features.

The following table lists optional features:

Note
The optional features listed in this table do not apply to Electronic Work Instructions.

To install this workspace or
component Select this feature

Teamcenter Easy Plan—Integrated
Manufacturing bill of materials (BOM)

Integrated Manufacturing BOM
Integrated Manufacturing BOM Client

Process Planning for BTO/BTS/CTO (Optional) Easy Plan—Electronics Process Planner

Note
Select Easy Plan—Electronics Process Planner to
integrate with Valor Electronics Manufacturing Solutions
software.

(Optional) Teamcenter Easy Plan—Product Configurator

Note
Select Easy Plan—Product Configurator Client to
support Product Configurator in your environment.
Product Configurator allows you to enable definitions for
variant formulas on operations.
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Please see the Product Configurator (Administrator)
documentation for installation details.

7. Click Next, and then click OK to verify that the specified services are not running.

8. Follow the instructions on the screen to complete this phase of the installation.

Click Close to exit Teamcenter Environment Manager.

9. In the Confirmation panel, click Start to begin the installation.
During the installation, you are prompted to provide the kit_location where you saved the Active
Workspace zip files, for example, C:\temp.

10. Navigate to the kit_location, select the requested zip files from folder and click Open.

11. After you complete the installation, click Close to exit Teamcenter Environment Manager.

3-4 Easy Plan 2412 ─ Deployment and Administration
Software Version Teamcenter 2412 Unpublished work. © 2024 Siemens



4. Updating with Teamcenter Environment
Manager
Teamcenter Environment Manager update overview

Teamcenter Easy Plan is a solution that contains several workspaces and generic components. This
documentation provides update instructions for everything in the Easy Plan solution. In places where
information is workspace-specific or component-specific, instruction options are presented in a table
format, to indicate which options you should select.

This documentation also provides update instructions for everything in Electronic Work Instructions. In
places where information is workspace-specific or component-specific, instruction options are presented in
a table format, to indicate which options you should select.

1. Verify that your Teamcenter environment meets requirements before you begin.

2. Update Teamcenter Easy Plan or Electronic Work Instructions on an installation.

3. Test the connection to the Teamcenter database.

Note
If you are installing Teamcenter Easy Plan, this step is not required for Teamcenter Manufacturing
Access.

Update with Teamcenter Environment Manager

Teamcenter Easy Plan is fully integrated with the Active Workspace installation kit. You do not need to
perform any extra installation steps.

Note
Teamcenter Environment Manager (TEM) is deprecated and will be obsolete in a future version
of Teamcenter. We recommend using Deployment Center to install Easy Plan or Electronic Work
Instructions. For further information, please see the following documentation:

• Installing Teamcenter using TEM (Linux)

• Installing Teamcenter using TEM (Windows)

• Installing Teamcenter Using Deployment Center

Teamcenter Environment Manager update overview
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Procedure

1. In the operating system Services dialog box, stop all Teamcenter services except FSC services.

2. (Optional) In the operating system Services dialog box, verify that these services have a status of
started.

• Teamcenter Process Manager—this service is only listed if you installed the Microservice
Framework kit.

• OracleOraDb11g_home2TNSListener

• OracleServiceGEOLUSDB

• OracleServiceTC

3. If you are installing Teamcenter Easy Plan or Electronic Work Instructions, download the Active
Workspace kit file from Support Center to your Active Workspace server.

• Tc2412_wntx64.zip

• Tc2412_lnx64.zip

4. If you are installing Teamcenter Easy Plan or Electronic Work Instructions, on the Active Workspace
server, unzip the downloaded ZIP file to a temporary folder, such as C:\temp. This is your kit_location.

5. On the Active Workspace server, choose Start → All Programs →Teamcenter → Environment
Manager.

6. In the Maintenance panel of the Teamcenter Environment Manager dialog box, click Updates
Manager and then click Next.

7. In the Update kit location field, browse to the Active Workspace kit location and click Open.

8. Click Next.

9. Verify that the services listed in the dialog box are not running, and click Close.

10. In the Optional Configuration Enhancements panel, select Yes, and then click Next.

11. In the Operating System User panel, type the operating system administrator user name and
password and then click Next.

Note
This is the same ID used to install Teamcenter.

12. In the Diagnostics panel, type in a working directory where log files can be created and click Run.

13. In the Teamcenter Administrative User panel, type the password and then click Next.

14. In the Confirmation panel, click Start to begin the update.

After completing the update, click Close to exit Teamcenter Environment Manager.
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5. Installing or updating with Deployment
Center
Install or update with Deployment Center

You can use Deployment Center to perform an installation or an update. For instructions about using
Deployment Center, see the Deployment Center documentation available on the Support Center.

Use these instructions if you already have Teamcenter foundation and Active Workspace installed on the
target machine onto which you are installing the kit. If you do not have any software installed on the
target machine, follow the Installing and Using Deployment Center instructions in the Deployment Center
documentation. After you perform those tasks, you can perform this procedure.

Procedure

1. On the target machine, map a drive to the Deployment Center software repository.

For example, if the Deployment Center is installed on C:\apps, on the target machine, map a drive to
C:\apps\deployment_center\repo\software.

Caution
You must map a drive to the Deployment Center software repository, or the installation will fail.

2. Log onto the Deployment Center to scan and send the current configuration of your existing
environment to the Deployment Center.

Note
See Register Environments in the Deployment Center documentation to send the current
configuration to the Deployment Center.

3. Download the Active Workspace software kit from the Support Center and copy it to the Deployment
Center software repository.

Note
Teamcenter Easy Plan is fully integrated with the Active Workspace installation kit. You do not need
to perform any extra steps to install these products.

4. Refer to Deploy Software in the Deployment Center documentation. When you reach the
Applications tab, scroll through the list and select the workspaces that you want to install or update.

When you select a workspace or component, the Deployment Center automatically selects all
dependencies associated with that workspace.

5. (Optional) If you are installing Teamcenter Easy Plan, you can install the following optional features in
your environment:

Install or update with Deployment Center
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• Electronics Process Planner—integrates Teamcenter Easy Plan with Valor Electronics
Manufacturing Solutions software.

• Easy Plan—Integrated Manufacturing BOM—supports Integrated Manufacturing bill of materials
(BOMs) in your environment.

• Product Configurator Extension for Easy Plan—supports Product Configurator in your
environment.
Product Configurator allows you to enable definitions for variant formulas on operations. Please see
the Product Configurator (Administrator) documentation for installation details.

6. Refer to Deploy Software in the Deployment Center documentation. When you reach the
Components tab, click Show all parameters  and type a unique value in the Port Settings field.

Caution
You must change the port number for before you install or update software Teamcenter Easy Plan,
Electronic Work Instructions, or Next Generation Planning on the Deployment Center. If you do not
change this value, the Deployment Center fails during future installations and updates.

Each kit that you install must use a unique port number for the Deployment Center.

7. Follow the steps in Run the deployment scripts in the Deployment Center documentation to run the
scripts for Active Workspace.

8. Test the connection to the Teamcenter database.

9. Configure common Teamcenter Easy Plan options, and then configure options for workspaces that
you installed.

Install or update with Deployment Center
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6. Completing a Teamcenter Manufacturing
Access installation
Teamcenter Manufacturing Access installation tasks

When you install or update Teamcenter Manufacturing Access, you do not perform several tasks required
for other Teamcenter Easy Plan workspaces. Depending on your environment, you do need to complete
some or all of the following tasks.

Task title Complete this task to...

Complete a Teamcenter Manufacturing Access
installation

Install and configure Teamcenter Manufacturing
Access

Update Teamcenter Manufacturing Access
components using TEM

Finish updating Teamcenter Manufacturing Access
using the Teamcenter Environment Manager (TEM)

Add Teamcenter Manufacturing Access Study
Manager to a rich client

Install Teamcenter Manufacturing Access Study
Manager onto a four-tier Teamcenter rich client.

Configure Process Simulate and NX for
Teamcenter Manufacturing Access

Configure communication between Process
Simulate or NX and Teamcenter Manufacturing
Access.

Note
This task is required for all environments.

Classification search prerequisites Verify that your environment meets all
requirements to enable classification search.

Indexing the classification server Index the server so that end users can locate
classification data.

End user configuration tasks

Before end users can work in Teamcenter Manufacturing Access, you must complete the following tasks

1. Configure common Teamcenter Easy Plan options.

2. Configure Teamcenter Manufacturing Access.

Complete a Teamcenter Manufacturing Access installation

Perform the tasks in this topic to properly install and configure Teamcenter Manufacturing Access.

Teamcenter Manufacturing Access installation tasks
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Note
The MFG Search page and TcMA Study Manager are in a Beta state. We are working to have it fully
functional in future Active Workspace patch releases.

Process Simulate now supports the Edge browser, and Active Workspace no longer supports Internet
Explorer.

Due to these changes, make sure your environment meets the following requirements:

• You must run Tecnomatix 2206.

Warning
Previous versions of Tecnomatix are not compatible with Teamcenter Manufacturing Access 2412.

• Tecnomatix 2206 requires a special hotfix for Microsoft Edge support.

• You must install Microsoft Edge on the client machine.

1. Use the Teamcenter Environment Manager (TEM) to install Microservices and Active Workspace
gateway.

• Client → Active Workspace Gateway

• Microservices → Microservices Framework

• Microservices → Declarative Artifact Service

• Microservices → File Repository Service

• Microservices → Teamcenter GraphicQL Service

2. Install these components on the Active Workspace server:

• Server Extensions → Active Workspace

• Server Extensions → Teamcenter Manufacturing Access

• Server Extensions → Active Content Structure

• Server Extensions → Reuse and Standardization→ Classification Server

3. Install these components on the Active Workspace client:

• Client → Active Workspace Client

• Client → Teamcenter Manufacturing Access Client

• Client → Reuse and Standardization→ Classification Client

4. Install these components on the indexing solution server:

• Active Workspace → Indexing Server → Active Workspace Indexer

• Active Workspace → Indexing Server → Active Workspace Indexing Engine

Complete a Teamcenter Manufacturing Access installation
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Configure hosting preferences

Before you can use Teamcenter Manufacturing Access, you must configure the correct hosting preferences
for your environment.

Note
Starting in version 6.2, the ActiveWorkspaceHosting.PS.URL is deprecated.

If you use the ActiveWorkspaceHosting.PS.URL preference, end users cannot connect to NX or use the
MFG Search in Process Simulate.

Study Manager (Teamcenter Manufacturing Access) hosting preferences

To connect to Study Manager
(Teamcenter Manufacturing
Access) from...

Configure this hosting
preference

Additional information (if
applicable)

Teamcenter rich client TCMAccessHosting.RAC.URL For a server named hostname
on port 3000, type: http://
localhost:3000.

Process Simulate and NX TCMAHosting.PS.URL The format for
this preference is http://
<serverhost>:<gatewayport>.

Plant Simulation ActiveWorkspaceHosting.PLAN
T.URL

Update Teamcenter Manufacturing Access components with TEM

Note
Before version 2.7, this product was named Teamcenter Manufacturing Access Server. In version 2.7
and later, this product is named Teamcenter Manufacturing Access. These are two different products.
During installation, if necessary, the Teamcenter Environment Manager (TEM) automatically deselects
the Teamcenter Manufacturing Access Server product for you.

1. Navigate to the TC_ROOT\install directory and run the TEM.bat file.

2. In Configuration Maintenance, select Perform maintenance on an existing configuration, and
click Next.

3. In the Feature Maintenance panel, click Add/Remove Features and then click Next.

4. Browse through the list and expand Extensions, and then expand Active Workspace Server.

5. Select Teamcenter Manufacturing Access, and click Next several times to complete the installation.

Update Teamcenter Manufacturing Access components with TEM
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The TEM installation automatically selects all dependencies for the workspace.

Add Teamcenter Manufacturing Access Study Manager to a rich client

Complete these steps to add Teamcenter Manufacturing Access Study Manager to a four-tier Teamcenter
rich client.

Note
You must complete this task to enable full functionality on a four-tier rich client. This task displays
the Open with Study Manager command, which allows end users to locate and modify study data in
Manufacturing Process Planner, and then send the data directly to Teamcenter Manufacturing Access
Study Manager.

1. From the kit_location, navigate to the tc folder.

Tip
You defined the kit_location when you installed or updated Teamcenter Easy Plan.

For example, you might have downloaded the Active Workspace kit to C:\Temp.

2. Unzip tca0tcmaccess_rac.zip into a temporary folder such as kit_location\tc\tca0tcmaccess_rac.

3. Navigate to the kit_location\tc\tca0tcmaccess_rac\plugins folder.

4. Copy all JAR files to the TC_ROOT\portal\plugins folder.

Configure Process Simulate and NX for Teamcenter Manufacturing
Access

After you install Teamcenter Manufacturing Access, you can install the required version of Process Simulate
or NX. Next, you can configure Process Simulate or NX for Teamcenter Manufacturing Access.

Configure Process Simulate for Teamcenter Manufacturing Access

When you install Process Simulate on Teamcenter, you must select the Set Teamcenter Connection
information check box and enter your Teamcenter web server information. This allows Teamcenter
Manufacturing Access commands to display in Process Simulate.

Note
For more information, see the Tecnomatix Installation documentation.

In the Tecnomatix- InstallShield Wizard dialog box, select an option:

Add Teamcenter Manufacturing Access Study Manager to a rich client
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• Teamcenter Web Server URL—Enter the complete URL of your Teamcenter server.

• TCCS Environment—Enter a Teamcenter environment.

For information on how to configure Teamcenter environments, refer to the TCCS sections in the
Teamcenter documentation. TCCS enables you to select from a list of preconfigured Teamcenter
environments.

Configure NX for Teamcenter Manufacturing Access

After you install the required version of NX, you must activate the Study Manager. For more information
about this task, see the NX Fixture Planner documentation.

1. Launch NX Fixture Planner.

2. Open the Customer Defaults dialog box.

3. Select the Show Study Manager Viewer check box and click OK.

Classification search prerequisites

Before you install components to enable classification search, verify that your environment meets these
requirements.

Classification search prerequisites
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Teamcenter server requirements

Note
Teamcenter server and Solr database must be installed on the same machine.

You must install the following features on the Teamcenter server:

• Active Content Structure

This feature is installed with the Active Workspace installation kit.

• Classification Server

• Active Workspace Indexer (TcFTSIndexer)

• Active Workspace Indexing Engine (Solr database)

Teamcenter Rich Client requirements

1. Navigate to TC_DATA\ftsi\solr_schema_files and verify that TC_ACE_SOLR_SCHEMA.xml is installed.

2. Verify that classified data is available in the database.

a. Launch a Teamcenter Rich Client and open the Classification application.

b. View the Classification classes to confirm that they contain data.

3. In the Teamcenter Rich Client, set the ICS_searchindex_view_visible preference to true.

4. Create an indexing view for each classification class.

Open a Teamcenter command prompt and execute the following command: smlutility
-create_indexing_views -u=<Tc-admin-user> -p=<password> -g=dba.

Note
This utility must be run by a user with Teamcenter administration privileges.

Tip
To confirm indexing view creation, open the Classification Admin dialog and verify that search index
view is listed below each classification class.

Index the classification server

After you verify that your environment meets all prerequisites, you can index the classification search data.

Index the classification server
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Caution
If you use grouping or non-storage classes and those classes contain subclasses, please contact the
Siemens Digital Industries Software Support Center for help with this procedure.

1. (Optional) Test the connection between the Teamcenter server and the Solr database.

Open a Teamcenter command prompt and execute the following command: runTcFTSIndexer
–task=objdata:test.

2. Select one of the following methods to index the classification search data.

• Open a Teamcenter command prompt and execute the following command: runTcFTSIndexer
—task=objdata:index

• If you use the Dispatcher for indexing, open a Teamcenter command prompt and execute the
following command: runTcFTSIndexer –dispatcher —task=objdata:index

Tip
You can review data logs to troubleshoot any issues. Each time you index data, new logs are
generated in C:\apps\TC12x\TC_Root\TcFTSIndexer\working\TcFtsIndexer_objdata.

3. Select one of the following methods to restart the indexing search engine.

• Open a Teamcenter command prompt and execute the following command: runTcFTSIndexer
-task=objdata:sync -interval=25

• If you use the Dispatcher for indexing, open a Teamcenter command prompt and
execute the following command: runTcFTSIndexer -dispatcher -task=objdata:sync
-interval=25

Note
If the indexer is running as a Windows service, enable the service.

Recover indexed classification search data

• Open a Teamcenter command prompt and execute the following command: runTcFTSIndexer —
task=objdata:recover.

Note
Only perform this step when classification search indexing fails.

Configure the environment for traditional Classification when Next Generation
Classification is installed

Beginning with Teamcenter Manufacturing Access 5.1, Next Generation Classification is installed. If you
want to continue using traditional Classification, you must change some BMIDE values.

Index the classification server
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1. Change BMIDE values to match the default values required for traditional Classification.

Open a Teamcenter command prompt and execute the following
command: business_model_updater -u=<Tc-admin-user> -p=<password> -g=dba
-file=C:\Users\Administrator\Desktop\BO_type_constant.xml -update=all
-mode=upgrade

Note
This utility must be run by a user with Teamcenter administration privileges.

2. Verify that the BMIDE values were updated so that the default value is false.

Open a Teamcenter command prompt and execute the following
command: gettypeconstantvalue -u=<Tc-admin-user> -p=<password> -g=dba
-typename=Cls0ClassBase -constantname=Awp0SearchIsClassifyDataIndexed

Note
This utility must be run by a user with Teamcenter administration privileges.

3. Complete changes to the BMIDE values.

Open a Teamcenter command prompt and execute the following command:
bmide_modeltool.bat -u=<Tc-admin-user> -p=<password> -g=dba -tool=all
-mode=upgrade -target_dir="%TC_DATA%".

Note
This utility must be run by a user with Teamcenter administration privileges.

Caution
You must always execute this command after you make changes to the BMIDE or Classification
Admin.

If you do not execute this command, Teamcenter does not complete your changes.

Index the classification server
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7. Additional installation tasks
Test the connection to the Teamcenter database

Note
You do not need to perform this procedure when you install Teamcenter Manufacturing Access.

Procedure

1. Open an HTML5 certified web browser.

Note
Teamcenter Easy Plan does not support Internet Explorer or Edge legacy because these browsers
are not compatible with key components of Process Planning for ETO. Siemens Digital Industries
Software recommends using the Google Chrome or Firefox browsers.

2. Unless you are installing Next Generation Planning, in the address bar of the web browser, type
http://hostname:Port </>.

If you are installing Next Generation Planning, in the address bar of the web browser, type http://
hostname:Port/.

Example
http://localhost:3000/

3. Enter a valid Teamcenter database user ID and password.

4. Click Login.

If your logon is successful, you can exit Teamcenter. If you cannot log on, contact Product Lifecycle
Management Support to correct the problem.

Install Opcenter for use in Easy Plan

Manually install Opcenter integration for Easy Plan. This allows you to connect product lifecycle
management (PLM) to automation, and to better connect product development and production.

Procedure

1. Change the file <TC_ROOT>/microservices/gateway/config.json.

Test the connection to the Teamcenter database
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a. Add a route to the routes section of config.json.

Example

"opcenterPreview": {
    "path": "/opcenterPreview",
    "target": “<BASE_URL>”
}

b. Add a valid value to the security csurfExclusions entry: "/opcenterPreview".

2. Change the value of the preference EP_OpenInOpcenterUrl to define the remaining URL.

Example
If the Opcenter preview URL is http://myhost:5555/preview/index.html, then:

• The <BASE_URL> in the route should be http://myhost:5555.

• The preference value should be preview/index.html.

Note
If you change the value of the preference EP_OpenInOpcenterUrl, the Open in EWI command is
hidden.

Updating Easy Plan using the epw_update_stx_elements utility

When an individual standard text library object changes, you can use the command line
epw_update_stx_elements utility to find and update HTML preview datasets attached to process or
operation revisions.

Preview datasets impacted by changes to a single, selected standard text object are updated when you run
the utility.

Requirements

After a standard text library object has been revised, updated and approved, it is a valid candidate for the
HTML bulk update utility.

• You must run the utility from a Teamcenter server.

• To provide controlled and predictable results, it is strongly recommended that you update only a single
standard library object prior to executing the bulk update. Because an individual HTML document may
contain references to multiple standard library elements, all standard library elements referenced within
a HTML document are regenerated within the updated HTML document.

Updating Easy Plan using the epw_update_stx_elements utility
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• You should run the utility at a time when users are not authoring HTML documents, and you should
prenotify users of expected changes. The HTML documents may be in a working or released state.

Caveats

The following are not part of the epw_update_stx_elements utility process and must be addressed
separately:

• Manufacturing Execution System (MES) integration.

• Change management.

Teamcenter recommends that you set a single manufacturing change notice (MCN) on a single
standard text library object. An in-depth understanding of the nature of changes made by the
update_stx_elements utility is essential to successful results. The TWI preview dataset used by
TWI and Electronic Work Instructions (EWI) supports HTML, based on the Teamcenter preference
MEWiPreviewFormat. Changes made to the TWI preview dataset attached to an Process/OP item
revision are absolute and datasets have no revision history.

• The utility does not support standard symbol library objects.

• If an HTML library object change requires additional changes to the BOP, such as changes to the number
of operations or changes to consumed parts, this is not a valid use of the bulk update utility.

Run the epw_update_stx_elements utility

The epw_update_stx_elements utility lets you systematically find the operation and process revisions that
contain work instructions that reference a specific HTML element in Teamcenter, and then update the
preview files offline rather than singly online.

Prerequisites

Procedure

1. In My Teamcenter, create a change notice and add the standard HTML element revisions to the
change notice’s Problem Items folder.

2. Apply the release status to the change notice revision.

3. Create or identify a saved revision rule that will configure the released revision of the standard HTML
elements.

4. Identify or create one or more saved revision rules that will configure the revisions of the operations
and processes whose work instructions need to be updated.

Run the epw_update_stx_elements utility
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You may use more than one rule, such as a latest working rule and a rule for the most recently
released and exported revisions.

5. Run the utility to search for processes and operations, specifying as input the change notice ID, the
revision rule names, logon credentials, and the findImpacted argument.

Upon completion of the search, the change item's Impacted Items folder contains any process and
operation revisions whose work instructions need to be updated. If necessary, you can review and
modify the list.

a. Run the utility again to update the textual work instruction preview files, this time using the
updateImpacted argument.

b. Send the updated process and operation revisions in the Impacted Items folder to downstream
applications for export.

Set up integrated plant BOM prerequisites

For users to be able to create a plant bill of materials (BOM) for a specific geographic location in Easy
Plan, you must set up plant locations and location codes in Teamcenter. If you are creating multiple plant
manufacturing bills of materials (MBOMs), you must define a local revision rule for each.

Note
On the Teamcenter Preferences page, use the site preference
EP_IntegratedBOMsupportedMBOM_types to specify which type of integrated MBOM is available in
Easy Plan. Valid values are GlobalMBOM or PLANTBOM. The default is GlobalMBOM.

Plant BOMs require the value PLANTBOM.

Set up plant locations

Log into Active Workspace as a Teamcenter administrator and do the following to add each plant.

Procedure

1. On the Home page, click Add .

2. In the Add dialog box, from the Type list, select Plant Location, type a Name and a Location Code,
and click Add.

The plant BOMs you added are now available to Easy Plan users.

Set up integrated plant BOM prerequisites
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Set up Revision rules

Open a Teamcenter command prompt to the bin location of the Teamcenter root directory, and use the
utility imb_create_plant_revrule to create a revision rule for each plant, as in the following example.

imb_create_plant_revrule -u=tcadmin -p=tcadmin -g=dba -plant=BERLIN 
-locationcode=BERLIN -revrules=”Working; Any Status”

Set up Revision rules
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Set up Revision rules
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8. Installing or updating TCM Visualization
TCM Visualization prerequisites

The Teamcenter Manufacturing (TCM) Visualization kit installs the required services for 3D visualization
in Teamcenter Easy Plan workspaces. You can use the Teamcenter Environment Manager (TEM) or the
Deployment Center to install TCM Visualization in your environment.

Note
TCM Visualization for Teamcenter Easy Plan is supported on Process Planning for ETO and on the
work instructions page for process stations in the Process Planning for BTO/BTS/CTO workspace. The
prerequisites are only required to install and use TCM Visualization for Teamcenter Easy Plan in these
workspaces.

Before you install or update TCM Visualization on Teamcenter Easy Plan, complete the following steps:

1. Download the following kits from Support Center:

• Teamcenter 13.x or 14.x base installation

• Teamcenter Active Workspace 2406

• Microservice Framework

• TCM Visualization

The TCM Visualization software kit is available from the Teamcenter downloads page on Support
Center. Select Additional Downloads→Manufacturing Visualization. Download the version that
matches your versions of Active Workspace and Microservice Framework.

2. Install Teamcenter with Active Workspace and Microservice Framework as described in the
Teamcenter installation guides for Windows and Linux.

3. Add Teamcenter Easy Plan components to Active Workspace.

Licensing disclaimer

The TCM Visualization kit is in a Beta phase for the Teamcenter Easy Plan 2406 release, and does not
require an additional license. In future releases, a separate license will be defined for TCM Visualization.

Add or update TCM Visualization using TEM

TCM Visualization prerequisites
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You can use the Teamcenter Environment Manager (TEM) or the Deployment Center to install Teamcenter
Manufacturing (TCM) Visualization. This topic provides instructions to add or update TCM Visualization
with TEM.

Note
Teamcenter Environment Manager (TEM) is deprecated and will be obsolete in a future version
of Teamcenter. We recommend using Deployment Center to install Easy Plan or Electronic Work
Instructions. For further information, please see the following documentation:

• Installing Teamcenter using TEM (Linux)

• Installing Teamcenter using TEM (Windows)

• Installing Teamcenter Using Deployment Center

Procedure

1. Add TCM Visualization features to TEM:

a. Click Start→All Programs→Teamcenter→Environment Manager.

Alternatively, launch TEM in Maintenance mode from the Teamcenter command prompt. Next,
change to the install directory from the Teamcenter root directory, and then run the tem.bat file
(on Windows systems) or the tem.sh script (on Linux systems).

b. In the Maintenance panel, click Updates Manager and then click Next.

c. In the Update kit location field, browse to the Active Workspace kit location and click Open.

d. Click Next and follow the instructions on the remaining panels to complete this part of the
installation.

When you complete this part of the installation, click Close.

2. Install TCM Visualization features:

a. Launch TEM in Maintenance mode.

b. In the Maintenance panel, choose Configuration Manager.

c. In the Configuration Maintenance panel, choose Perform maintenance on an existing
configuration.

d. In the Old Configuration panel, select the configuration you want to modify.

e. In the Feature Maintenance panel, select Add/Remove Features.

f. In the Features panel, select the following features:

• TCM Vis — Easy Plan Service

• TCM Vis — Visualization Service
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g. In the TCM Visualization Service panel, Teamcenter Web Tier URL box, enter the URL to the
Teamcenter web tier, for example, http://myHost:7001/tc.

h. Proceed through the remaining panels to complete the TCM Visualization installation, then exit
TEM.

3. To complete the TCM Visualization installation, update the microservice framework master node and
redeploy the Teamcenter web tier as described in the Teamcenter installation guides for Windows and
Linux.

4. Proceed through the remaining panels to complete the TCM Visualization update, then exit TEM.

Update TCM Visualization with TEM

Procedure

1. Launch TEM in Maintenance mode.

2. In the Maintenance Panel of the Teamcenter Environment Manager dialog box, click Updates
Manager.

3. In the Update kit location field, browse to the Active Workspace kit location and click Open.

4. Click Next and follow the instructions to update TCM Visualization, then exit TEM.

Add or update TCM Visualization with Deployment Center

You can use the Deployment Center or the Teamcenter Environment Manager (TEM) to perform an
installation or an update in your environment. Use these instructions install or update TCM Visualization
with the Deployment Center.

Procedure

1. Add the TCM Visualization software kit to the Deployment Center software repository as described in
Manage Repositories in the Deployment Center Guide.

Note
If you created your Teamcenter environment using TEM, register your environment in Deployment
Center as described in Register environments in the Deployment Center Guide.

Make sure the Active Workspace software kit is in the software repository. Easy Plan applications
are included in the Active Workspace software kit.

Teamcenter Manufacturing Access is installed during the Active Workspace installation process. You
do not need to download a separate kit for configuration.

2. In Deployment Center, select your existing environment.

3. In the Applications task, click Edit Selected Applications to add applications.
The Available Applications panel displays the available applications.

Update TCM Visualization with TEM
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4. In Available Applications, choose Easy Plan applications:

(Optional) Product
Configurator Extension for
Easy Plan

Supports Product Configurator in your environment. Product
Configurator allows you to enable definitions for variant formulas
on operations. See the Product Configurator (Administrator)
documentation for installation details.

(Optional) Electronics
Process Planner

Integrates Process Planning for BTO/BTS/CTO with Valor Electronics
Manufacturing Solutions software.

5. Click Update Selected Applications to add applications to the Selected Applications list.
The added applications show Pending Install status in the Selected Applications list.

6. Proceed to the Components task. Select the Microservice Node component and click Show all
parameters. Type a unique value in the Port Settings field.

Caution
You must change the port number before you install or update Easy Plan on the Deployment
Center. If you do not change this value, the Deployment Center fails during future installations and
updates.

Each kit that you install must use a unique port number for the Deployment Center.

Note any components whose configuration status is not 100%. Update each component’s required
values, and then click Save Component Settings until all components show a configuration status of
100%.

7. Proceed to the Deploy task. Click Generate Install Scripts to generate deployment scripts to update
affected machines. When script generation is complete, note any special instructions in the Deploy
Instructions panel.

8. Locate deployment scripts, copy each script to its target machine, and run each script on its target
machine.

For more information about running deployment scripts, see the Deployment Center Guide.

9. To complete the TCM Visualization installation, update the microservice framework master node and
redeploy the Teamcenter web tier (tc.war) as described in the Teamcenter installation guides for
Windows and Linux.

Add or update TCM Visualization with Deployment Center
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9. Configuring access by groups and roles in
Teamcenter Easy Plan
Configuring user access

Starting with version 6.2, Easy Plan no longer uses workspaces to define what end users see upon login.
Now end users are all part of the same workspace, and the solutions in which they work are based on
preferences. Those preferences are part of the installation process.

Groups and roles

Preferences are defined by groups and roles, and you can use those groups and roles to grant end users
access to the data and solutions they need.

Caution
Teamcenter Easy Plan does not provide a set of default groups and roles, such as the ones listed in this
topic. The groups and roles listed in this topic are examples only.

You must create the groups and roles that meet your organization's requirements.

Groups

You can define groups based on the solutions required in your environment. Here are some examples of
groups that you can define:

• Automotive (Auto)

• Component manufacturing (ComponentMFG)

• Consumer packaged goods (CPG)

• Large engineer to order (LargeETO)

• Small ETO (SmallETO)

• White goods (WhiteGoods)

Roles

You can assign one or more roles to a group. Here are some examples of roles that you can create, define,
and assign to a group:

• Planner—these end users have read and write access to process planning pages and related data.

Configuring user access
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• Operator—these end users have read and write access to Electronic Work Instructions data.

• ME—these end users have read and write access to EBOM-MBOM alignment data.

Preferences

Preferences are defined by groups and roles, and there is a different configuration for each preference.
When an end user logs in with the correct preference, they get the solution or pages they need.

Preference name Specifies Values

EP_WorkPackageContentTyp
e

Which structures are allowed in
work packages on the Manage
Work Package page.

Note
You must configure this
preference to ensure that the
correct Tasks tiles display on
the Manage Work Package
page.

Product

PlantBOP

ProductBOP

EBOM:PSBOMViewRevision

MBOM:PSBOMViewRevision

Plant:PSBOMViewRevision

BOP:PSBOMViewRevision

EP_hasMixedProductionWPA
uthoringPermissions

Whether users can author work
package content that supports a
mixed production solution.
Set this preference to true to
enable mixed production work
package authoring for users.

true
false

EP_PlanningForSmallProdu
ct

Users work with small products
in your environment.

true

false

Preferences
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Note
If you enable this preference,
the High Level Planning page
and related features do not
display.

EP_ShowOnlyEWI Work packages created by this
preference can only be opened in
Electronic Work Instructions.

true

false

EP_ProductVariantsTiles Which tiles are displayed for
variants on the Manage Work
Package page.

ConfiguratorContext

ProductionProgram

EP_EnableLineBalancing Line balancing features are
enabled.

You can enable this preference
during installation.

true

false

EP_TimeAnalysisMode Which time analysis mode is
applied to data.

TICON

ACTIVITIES

CLASSIC_ACTIVITIES

Preferences
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10. Configuring Teamcenter Easy Plan
Configuring common Easy Plan options

Common Easy Plan configuration options

Easy Plan workspaces and components share several common configuration options. Use the matrix to
determine shared configuration options.

Options

Process
Planning for
BTO/BTS/CTO

Process
Planning for
ETO TCMA

Active
Workspace
Search
capabilities

✓ ✓ ✓

Autocomplete
source for
parts in the
Work
Instructions
Editor

✓ ✓ X

Configure
change
management

✓ ✓ X

Limits for
object type
and subtype
lists

✓ ✓ ✓

Open
Teamcenter
Easy Plan
applications
from
Manufacturin
g Process
Planner

✓ ✓ ✓

Other key
preferences

✓ ✓ ✓

Reporting
capabilities

✓ ✓ X

Configuring common Easy Plan options
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Table column
preferences

✓ ✓ ✓

Time analysis ✓ ✓ X

Time unit
properties

✓ ✓ X

Time analysis
priority

✓ X X

Active Workspace Search capability

Active Workspace indexing provides the basis for full-text search from the Active Workspace client and Easy
Plan workspaces. To search any product structure, you must first index it.

See Indexing in the Active Workspace Deployment documentation for details on the installation and
configuration of this search mechanism.

Auto-predict source for parts in the Work Instructions Editor

The EP_AutoPredictForPartsSource preference defines the source that automatically predicts and
completes parts in the Work Instructions Editor. You can use this preference in Process Planning for
BTO/BTS/CTO and Process Planning for ETO.

The accepted values for this preference are:

• Assignments—auto-predict list includes the parts that are assigned to the selected operations.

• Associated—auto-predict list includes the first-level children of the associated assembly.

The default protection scope for this preference is SITE and the category is EasyPlan.

Limits for object type and subtype lists

When you create a new object in Teamcenter Easy Plan, you must select a type from the list. By default this
list displays the object and all associated subtypes. You can limit object subtypes to match your business
environment.

Note
If the preference does not exist for a type or is empty, all available subtypes are displayed. There are
no default values for these preferences. If there is only one valid subtype defined for one of these
preferences, that subtype is automatically selected.

Active Workspace Search capability
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There are preferences for several object types.

For a plant:

• EP_CreateSubtypesForType_MEWorkarea—defines the list of work area types (subtypes) for the root
plant node in Process Planning for BTO/BTS/CTO or Process Planning for ETO.

• EP_CreateSubtypesForRootType_MEWorkarea—defines the list of work area types (subtypes) within a
plant structure in Process Planning for BTO/BTS/CTO or Process Planning for ETO.

For a plant bill of process (BOP):

• EP_CreateSubtypesForRootType_Mfg0MEPlantBop—defines the list of plant bill of process (BOP)
types (subtypes) that end users can define in a work package in Process Planning for BTO/BTS/CTO.
The base type is Mfg0MEPlantBop.

• The EP_CreateSubtypesForType—preference defines the subtypes listed when end users create a work
package. The default value is Type.

• EP_CreateSubtypesForType_MEProcess_InProductBop—defines the subtypes listed when end users
create a functional group in a product BOP. The default value is Mbc0FuncGroup. If you need to
maintain compatibility with data created in Teamcenter Manufacturing Process Planner (or add any
other data derived from MEProcess), change this value to MEProcess.

Note
A functional group is an object used to group operations in the product BOP. In Teamcenter
Manufacturing Process Planner, the MEProcess object type is used as the functional group.

• EP_SearchInBOEPropertyNames—allows users to search in the Resources tree, also known as the Bill
of Equipment (BOE), on the Process Planning page. This preference value must be the "User Entry
Name" of the property in the query.
Note
You must also include the properties listed in this preference in the query that you specify in the
EP_SearchInBOEByPropertyQueryName preference.

• EP_SearchInBOEByPropertyQueryName—defines the query that is used to search in the Resources
tree, or the BOE in the Process Planning page.

• EP_ShowFullBOEInResources—enables Easy Plan to display the full BOE structure in the Resources tab
on the Process Planning page. When this preference is enabled, users can select objects in the BOE and
assign them to a process or operation by dragging them to the Resources tab for the selected object.

You must set this preference to True to enable the feature. In addition, you must add
EP_ShowFullBOEInResources to the AWC_Startup_preference in the Teamcenter rich client.

• MfgMEPlantBOP.Mfg0MEPlantBOP.PasteDuplicateTemplate—enables Easy Plan users to clone
existing functional groups in the Product BOP Authoring and Process Planning pages into process
areas, process stations and process lines based on cloning rules.

For a product BOP:

Limits for object type and subtype lists
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• MEProductBOP.MEProductBOP.PasteDuplicateTemplate—enables Easy Plan users to clone existing
functional groups in the Product BOP Authoring and Process Planning pages into process areas,
process stations and process lines based on cloning rules.

For a process resource:

• EP_CreateSubtypesForType_Mfg0ProcResource—generates a list of values to display when end users
create a process resource. The default values for this preference are:

◦ Mbc0HumanPR

◦ Mbc0MachinePR

◦ Mbc0CobotPR

For a process area:

• EP_CreateSubtypesForType_Mfg0MEProcArea—limits the types of process areas in Process Planning
for BTO/BTS/CTO (for example, process line, process station, and process area).

For a process station:
• EP_AllowDropResourceOnTarget—allows Easy Plan users to populate resources at the process station

level, and defines the object types onto which users can drag resources. This preference supports
multiple values separated by commas using the add value function. The default values for this
preference are:

◦ Mfg0BvrOperation

◦ Mfg0BvrProcess

◦ Mfg0BvrProcessResource

For an engineering bill of materials (BOM, EBOM) or a manufacturing bill of materials (MBOM):

• EP_SearchSubtypesForEbom—defines the subtypes listed when end users create work packages.
Ensure that you set this preference so that people can configure EBOMs in your environment.

• EP_SearchSubtypesForMbom—defines the subtypes listed when end users create work packages.
Ensure that you set this preference so that people can configure MBOMs in your environment.

For an MEProcess:

• EP_CreateSubtypesForRootType_MEProcess—defines the list of process types (subtypes) for the root
process.

• EP_CreateSubtypesForType_MEProcess—defines the list of process types (subtypes) within a process
structure.

• Ics_classifiable_types—enables the classification of processes and operations. Set the value of this
preference to MEProcess, MEProcessRevision, MEOP, and MEOPRevision.

For an operation (MEOP):

Limits for object type and subtype lists
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• EP_CreateSubtypesForType_MEOP—defines the list of operation types (subtypes) within an operation
structure in Process Planning for BTO/BTS/CTO or Process Planning for ETO.

• EP_CreateSubtypesForType_MEOP_InProductBop—defines the list of operation types (subtypes)
within an operation structure in a product BOP Process Planning for BTO/BTS/CTO or Process Planning for
ETO. The default value for this preference is MEOP.

• Ics_classifiable_types—enables the classification of processes and operations. Set the value of this
preference to MEProcess, MEProcessRevision, MEOP, and MEOPRevision.

Relation types and file types

You can use these preferences to configure relation types and file types in your environment.

Note
If you modify any of these preferences, you must restart the server for the changes to take effect.

• The EP_LayoutRelation preference defines how relation types are set for process areas and line layouts
in Teamcenter Easy Plan. This is a single value. The default value is Mbc0LayoutRelation.

• The EP_FileTypesForLayoutDataset preference controls which file types end users can upload as
process area and line layouts. Only 2D image file types are supported. Default file values include bmp,
jpeg, jpg, pdf and png.

• The DRAG_AND_DROP_default_dataset_type preference controls the relation type assigned to a
process area or line layout when end users upload it into Teamcenter Easy Plan. The format for each
value is FileExtension:DatasetType. For example, jpeg:Image.

Add an MBOM to a work package by mirroring an EBOM structure

In the manufacturing bill of materials (MBOM) panel on the Manage Work Package page, the option
Add MBOM using Mirror is available when users click Add . Based on existing Teamcenter preferences,
the Add MBOM using Mirror command adds a linked MBOM to your work package by mirroring an
engineering bill of materials (EBOM) structure.

In accordance with existing Teamcenter MBOM mirror preferences, the Add MBOM using Mirror
command is enabled for the specified EBOM structure.

• If an MBOM with an expected ID already exists in the database, that MBOM is added to the work
package.

• If such an MBOM does not exist, a new MBOM is created.

To enable this option, you must define correct values for the following Teamcenter preferences:

• MEMBOM_Mirror_TypePrefixSuffix = Item,M_

Relation types and file types
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• MEMBOM_Mirror_MakeRules = KEY:Usage_ArchitectureId,VALUE:H| VALUE:L

Note
The above KEY values are examples.

Additional MBOM mirroring preferences that you can use include:

• MEMBOM_Mirror_AlignProperties

• MEMBOM_Mirror_IgnoreRules (Value: KEY:GCS CP,VALUE:SKIP,ACTION:Skip|
VALUE:TRAVERSE,ACTION:Traverse)

• MEMBOM_Mirror_MakeRules (KEY:GCS CP,VALUE:Make|VALUE:Phantom)

• MEMBOM_Mirror_TypePrefixSuffix

Note
• If you also want to copy EBOM attributes from an EBOM to an MBOM, according to property

type, you can align properties using the preference MEAlignedPropertiesList or the preference
MEMBOM_Mirror_AlignProperties.

• If you create a mirrored MBOM from a source EBOM, later remove that MBOM from your work
package, and then try again to create a mirrored MBOM, the source EBOM is mirrored again unless
you or your administrator change the value of the preference MEMBOM_Mirror_TypePrefixSuffix.

Change management

Change Management preferences are also used by Teamcenter Manufacturing Process Planner. For more
information, see the Teamcenter Manufacturing Process Planner documentation.

• The MEReleaseStatusListForAutoRevise preference contains a list of valid release status names. The
default values are TCM Released and PlanningSyncState. Replace these values to match your business
needs.

Note
This preference also controls revisioning on statused objects. If a user has revision rights and attempts
to modify a statused object, Teamcenter Easy Plan prompts the user to create a new revision.

Example
A user moves an operation to another station. If one of the stations is released, Teamcenter Easy Plan
revises it.

Change management
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• The MEMCN_change_notice_mandatory_types preference requires Process Planning for BTO/BTS/CTO
and Process Planning for ETO users to create a manufacturing change notice before they can edit certain
types of BOPs.

Note
This preference is shared with Teamcenter Manufacturing Process Planner. For more information, see
the Manufacturing Process Planner and Administering Manufacturing Planning documentation.

• The MEMCN_management_enabled preference enables ChangeNoticeRevision-related commands to
display in Teamcenter Manufacturing Process Planner application. The default value is false. Set this
preference to true to display the commands.

• The MEMCN_release_statuses preference defines the list of mutually exclusive release statuses for a
ChangeNoticeRevision. A ChangeNoticeRevision is associated to a Bill of Material (BOM) window, and
only one release status may be associated to the ChangeNoticeRevision at any stage. The default values
are Pending and TCM Released. Replace these values to match your business needs.

Datasets and occurrence types

You can specify these dataset and occurrence type preferences in your environment.

• EP_AssignedDocumentsItemType—defines the list of object types that Teamcenter Easy Plan displays
and that end users can paste into the the Document tab.

You can define the object type from either the Item or Document type. The value for this preference is
the internal object name, for example, Document or custom_type.

• EP_ProductBopPlantBopAccountabilityCheckDataset—Configures the dataset name to use for the
partial match check in Show indication information mode. This preference is only available in Process
Planning for BTO/BTS/CTO.

• MBC_RelationTypeAssignedDocuments—Contains a list of occurrence types that identify the assigned
items that are handled as document items. Those occurrence types display on the Documents subtab.
The default value is in the format <relation_type>:<dataset_type>.

You can define the object type from either the Item or Document type. The value for this preference is
the internal object name. The default value is Mbc0EPDocument.

• MBC_VisibleDatasetTypes—Specifies which datasets display in the Files tab. The default value is in the
format <relation_type>:< dataset_type>.

• MEDisplayOccurrenceType—Defines the conditions in which occurrence types display. The value for
this preference is in the format <relation_type>:< dataset_type>. Some of the default values are:

◦ MEOP:Document:MBC_RelationTypeAssignedDocuments

◦ MEProcess:Document:MBC_RelationTypeAssignedDocuments

Datasets and occurrence types
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Note
The list of occurrence types for consumed parts is only populated from the
MEDisplayOccurrenceType preference.

• MEReleaseStatusList—Adds the Attach file command on the Information tab. This command is only
available for dataset types that you specify in this preference. The values for this preference follows the
format <relation type>:<dataset type>.

Process area nodes

You can use the following preferences to specify which datasets attach to process area nodes.

Note
You must configure both the DRAG_AND_DROP_default_dataset_type and
MBC_AllowedDatasetTypes preferences before end users can attach movies, such as MP4 files, to an
operation in your environment.

• DRAG_AND_DROP_default_dataset_type—Contains a list of default dataset types associated to files
dragged in Teamcenter.

The default value is in the format <file_extension>:<dataset_type>. For example: doc:MSWord.

Note
To attach movies such as MP4 files to an operation, add mp4:CAEAnalysisDS to the list of values.

• EP_FileDatasetRelations—Contains a list of default dataset types associated to files dragged in
Teamcenter. This preference must be set so users can drag parts and files onto the Editor in the Work
Instructions Authoring page. Set the preference to include the following relation type values:

◦ IMAN_specification

◦ IMAN_reference

◦ IMAN_Rendering

◦ TC_Attaches

◦ IMAN_UG_altrep

◦ IMAN_UG_scenario

◦ IMAN_Simulation

• MBC_AllowedDatasetTypes—Contains a list of allowed dataset types for the Create dataset and Quick
overview dialog boxes. The default value is in the format <relation_type>:< dataset_type>.
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Note
To attach movies such as MP4 files to an operation, add IMAN_reference:CAEAnalysisDS to the list of
values.

Other key preferences

You may want to set these other key preferences in your environment.

• AWS_SearchPreFilter_Property2—Configures the list of search types on the main page. Active
Workspace also uses this preference.

• <class name>.CellProperties—Configures the cell properties for each object type. This preference
controls the data displayed in search results and in the breadcrumb.

Note
You can also configure the Details tab for each object page. This tab shows the summary style sheet
for the open object. You can modify these style sheets to configure properties:

• <class name>easyplan.CREATERENDERING—Configures rendering preferences. This preference
activates the create style sheets option in Teamcenter Easy Plan application Create dialog
boxes. For example, to use a rendering style sheet for MEOP, you create a preference named
MEOPeasyplan.CREATERENDERING.

Note
You must register style sheets in Active Workspace or Teamcenter before your end users can use style
sheets. For more information, see the Active Workspace and Teamcenter documentation.

OpenTeamcenter Easy Plan applications from Manufacturing Process Planner

Note
This functionality is optional.

Use the Teamcenter rich client to add the following application commands to Teamcenter Manufacturing
Process Planner:

• Open with Process Planning for BTO/BTS/CTO, used in Process Planning for BTO/BTS/CTO.

• Open with Study Manager, used in Teamcenter Manufacturing Access

• Open with Easy Plan Process Planning for ETO, used in Process Planning for ETOProcess Planning for
ETO.

Use the EP_domainUrl preference to point to the Active Workspace application server. For example, if your
server name is hostname and the port is 3000, type http//:localhost:3000.

Other key preferences
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Note
To add the Open with Study Manager command for Teamcenter Manufacturing Access, set the
EP_domainUrl preference to point to the Active Workspace application server. For example, if your
server name is localhost and the port is 3000, type http//:localhost:3000.

Reports

End users can generate reports in either Microsoft Excel or PDF file format. As an administrator, you can
add, remove, or modify default reports. For each report you modify, you must define these settings:

• A display name, which is shown in the Create Reports dialog box.

• The report output format (Excel or PDF).

Excel format

Easy Plan provides out-of-the-box templates to generate reports in Microsoft Excel format. You can also
define reports specific to your environment. When you define Excel reports, you must include the display
name, the report output format, and the Excel template used to create the report. Use this format for Excel
reports:

<report type>:EXCEL:<TemplateDatasetName>

For example, EPExcelPAReport:EXCEL:ExcelReportTemplate

Note
Reports generated in Excel rely on Excel reporting capabilities in the Teamcenter rich client. For
information, see the Teamcenter rich client documentation about Exporting Data to Microsoft Excel.

PDF format

You can define PDF reports specific to your environment. When you define PDF reports, include the display
name and report output format. In addition, include:

• An XSL style sheet to determine the page layout.

• An Apache formatting objects processor (FOP) configuration data set to determine the output file
format.

• The object types that are applicable for this report type.

Reports
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Use this format for PDF reports:

<report type>:<output format>:<transfer mode>:<stylesheet dataset>:
<Logo icon for the report>:<FOP configuration dataset>

For example, SFPMaterialReport:PDF:SFP_OperationReportTM:SFP_MaterialReportFormatDataset:
SFP_ReportLogoDataset:SFP_ReportFOPConfigurationDataset

Report definitions

The Mbc0Report Teamcenter preference contains report definitions and defines report properties. Each
entry in the Mbc0Report preference represents a report type and the details needed to generate the
report. Each object type contains a list of relevant reports for that type. Edit this preference file to add,
remove, or modify reports.

Each report type is related to an object type. To relate a report type to an object type, use these
Teamcenter preferences:

• MBC_REPORT_Mfg0BvrOperation, which provides a list of report types for operations. The default
values are:

◦ SFPOperationReport:Operation Report

◦ SFPMaterialReport:Material Report

• MBC_REPORT_ Mfg0BvrProcess, which lists reports for process objects.

• MBC_REPORT_Mfg0BvrProcessStation, which provides a list of report types for process stations. The
default values are:

◦ SFPStationReport:Station Report

◦ SFPMaterialReport:Material Report

Note
The format for these Teamcenter preferences entries is <<report type (string identifier for the
report)>:<report display name>>. For example, the entry SFPMaterialReport:Material Report tells
you that when a user selects the Material Report from the Create Report dialog box, the
SFPMaterialReport runs.

Install prerequisites for PDF reports

You must install the Apache Formatting Objects Processor (FOP) to generate PDF reports.

1. Verify that Java is installed on the server machine, and that the JAVA_HOME environment variable
points to the location where Java is installed.

Report definitions
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Note
Java must be installed before you can install Apache FOP.

2. Browse to the Apache FOP page (http://xmlgraphics.apache.org/fop/download.html) and
download version 2.7 or earlier for your operating system:

Caution
Apache FOP version 2.8 is not compatible with Teamcenter reporting capabilities.

• For a Windows operating system: fop-n.n-bin.zip

• For a Linux operating system: fop-n.n-bin.tar.gz

3. Extract the ZIP or GZ file on the server machine into the install folder you want to use.

Apache FOP creates a folder when it is extracted. For example, if you extract the file into the C:\apps,
Apache FOP creates the C:\apps\fop-n.n folder.

Tip
This path cannot contain any spaces.

4. Browse to the fop subfolder.

For example, browse to C:\apps\fop-n.n\fop.

5. Create or edit a system environment variable named TC_FOP_HOME, and set its value to the fop
folder.

The path you specify should contain the fop.bat file. For example, type C:\apps\fop-n.n\fop.

6. Edit the fop.bat file to support files containing large amounts of data:

• Locate the JAVAOPTS definition in the file.

• Add the -Xss4m parameter to the end of the definition.

7. Save and close the file.

Configure a custom report

You can add, delete, or modify the list of out-of-the-box reports to fit your environment.

1. Start Teamcenter rich client and log in as an administrator.

2. In Teamcenter, choose Edit → Options  and click the Search tab at the bottom.

3. In the Options dialog box, locate the Mbc0Report preference.

4. Edit the Teamcenter Mbc0Report preference to add a new report.

Configure a custom report
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Note
You can also modify or delete an existing report on the list.

5. Exit the Teamcenter rich client.

If you create a PDF report, you must also do the following:

• Open a Teamcenter command window.

• Add a new style sheet data set. For example, in the Teamcenter command window, type:

import_file -u=<Tc-admin-user> –p=<password> -g=dba –f=c:/temp/
MaterialReport.xsl 
-d=My_CustomReportFormatDataset -ref=XSL -type=XMLReportFormatter -de=r

In this command, -f is the full path and file name of the XSL file, and -d is the new data set name.

Note
This utility must be run by a user with Teamcenter administration privileges.

Table columns

On the Process Planning page, you can configure which table columns are displayed. Each table uses a
preference to control the properties displayed in it. Each preference has the format: EP_<<tab name><grid
name>>ColumnConfiguration. Each column is one property of the objects displayed in the table.

Tip
The preferences listed here control how data is displayed in the Process Planning for BTO/BTS/CTO
and Process Planning for ETO workspaces. See the Active Workspace Installation for details about the
properties associated with the preferences.

The EP_AssignedWorkareaTabColumnConfiguration preference defines properties in Process
Planning for BTO/BTS/CTO and Process Planning for ETO tables. This preference controls the
Workarea table columns that display objects assigned to a selected operation. Values for
EP_AssignedWorkareaTabColumnConfiguration include:

• ImanItemBOPLine.object_string

• ImanItemBOPLine.bl_rev_object_name

• ImanItemBOPLine.bl_rev_object_desc

Here is a list of preferences you can use to control properties displayed in Process Planning for BTO/BTS/CTO
tables:

Table columns
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• EP_BoeTreeTableColumnConfiguration—controls the bill of equipment (BOE) items that are displayed
in table columns on the Resources tab.

• EP_StationPagePlanningTabOperationsColumnConfiguration—controls the operation table columns
in the process station object Planning tab.

• EP_ProcessAreaPageProcessAreaGridColumnConfiguration—controls the columns of the Area table
on the process area object page.

• EP_ProcessPageTabProcessAssignedToolsAreaColumnConfiguration—controls the columns of
the Assigned Resources table on the process area object page. Values include
ImanItemBOPLine.bl_rev_fnd0IcsClassNames and ImanItemBOPLine.bl_occ_type.

• EP_PartAssignmentTabProductAreaColumnConfiguration—controls the columns of the Product table
on the Part Assignment subtab.

• EP_ProductTabTreeGridColumnConfiguration—controls the column configuration of the Product
panel on the Process Area page.

Note
Set the EP_ProductTabTreeGridColumnConfiguration preference if you have any version earlier than
Teamcenter 12.4.0.2 installed. The application will display the entire manufacturing bill of materials
(MBOM) in the Product panel on the Process Area page.

• EP_TargetAssembliesTabTableColumnConfiguration—controls the column configuration in the
Target Assembly tab on the Process Sequence panel. The Process Sequence panel is displayed when
end users perform high-level scoping for an MBOM at a specific level in the plant BOP.

Note
This feature requires Teamcenter 12.4.0.2 or later. You can use the
EP_TargetAssembliesTabTableColumnConfiguration preference to set properties in the Target
Assembly tab.

If you are running an earlier version of Teamcenter, you can set the
EP_ProductTabTreeGridColumnConfiguration preference.

You can use this list of preferences to control columns displayed in Process Planning for ETO tables:

• EP_ProcessPageTabProcessDetailsAreaColumnConfiguration controls the process and operations
table columns.

• EP_PartAssignmentTabProductAreaColumnConfiguration controls the product table columns.

• EP_ProcessTreeAssemblyPlanningColumnConfiguration enables the Classification column on the
Process tree table. To display this column, add the ImanItemBOPLine.bl_rev_fnd0IcsClassNames
value to the preference.

Table columns
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Variant rules

Starting in Teamcenter Easy Plan 2406, end users can save global or local variant rules while working in
the EBOM-MBOM Alignment, High Level Planning, and Process Planning pages within Teamcenter Easy
Plan.

The EP_SVROwningItemAllowedTypes preference defines the object types on which end users can save a
local variant rule in Teamcenter Easy Plan.

This preference is passed as a string property and accepts multiple values delimited by colons (:) in the
following format: Mfg0BvrObjectType.

The default value is Mfg0BvrProcessLine.

End users can save variant rules on objects in the following structures:

• Manufacturing bill of materials (MBOM)

• Plant bill of process (BOP)

• Classic BOP

• Custom object types

Note
We recommend defining types that represent a project or an order, for example a process line or a
process zone, and not common types like an operation or a process.

In addition, you must add EP_SVROwningItemAllowedTypes to the AWC_Startup_preference in the
Teamcenter rich client.

See the Preferences section in the Active Workspace Administration documentation for a description of
preferences and how to set them.

Configure manufacturing time

Add the MTM data card to Teamcenter Easy Plan

The MTM data card performs time analysis in Teamcenter Easy Plan workspaces.

Procedure

1. Browse to the kit location \tc folder.

2. Unzip the ept0timeanalysis_install.zip file.

Variant rules
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3. Browse to the ept0timeanalysis_install\install\ept0timeanalysis\jar folder.

4. Copy the *mtmdatacardutility*.jar file to the TC_ROOT\portal\plugins folder.

5. Unzip the MTMDataCard.zip file.

6. Copy the MTMDataCard folder to a location on the Teamcenter server, such as C:\Program
Files\Siemens\MTMDataCard.

Tip
• You can also copy the MTMDataCard folder to a mapped network drive on the Teamcenter

server.

You must copy the MTMDataCard folder to a mapped network drive. Teamcenter Easy Plan does
not support Universal Naming Convetion (UNC) file paths.

• Note the path to the index.html file in this folder. You need this information to configure time
analysis capabilities for end users.

7. (Optional) Run the TC_ROOT\portal\registry\genregxml.bat file to ensure that the
*mtmdatacardutility*.jar file is loaded into the Teamcenter rich client, and ready for time analysis
configuration.

What to do next

Note
Before end users can perform time analysis, you must configure a preference for the MTM data card.

Add custom MTM data cards to Easy Plan

You can add custom MTM data cards to Teamcenter Easy Plan, and then manufacturing engineers can add
the MTM codes as activities for a specific operation. All custom MTM data cards used in your environment
must meet the following requirements when you add them to Teamcenter Easy Plan.

Requirement Details

MTM data cards Each MTM data card must be standalone. You
cannot group multiple data cards into a single
HTML file.

Add custom MTM data cards to Easy Plan
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<script> tag with empty function You must create an HTML file for each data card.
The HTML file must contain a script tag, and inside
that tag there must be an empty function.

<script> 

function MTMnavigate() {}

</script>

Activity element For every HTML element <?> that represents an
activity

No href attribute (if using <a> tag)

Add onClick attribute:

onclick="MTMnavigate(0, <CODE>, 
'', '',<TIME>,<DESC>);"

customDataCardsFolder Add the customDataCardsFolder folder in the
assets\cards directory.

The customDataCardsFolder contains the custom
MTM data cards (customDataCard1.html,
customDataCard2.html, etc.).

assets\cards.html file Edit the assets\cards.html file:

Add custom MTM data cards to Easy Plan
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In the <body> element – add the section for the
custom data cards

<span class="parent" 
onClick="toggleExpansion('brn_CUSTO
M', 'img_CUSTOM')">

 <img src="icons/plus.gif" 
id="img_CUSTOM">Custom<br>

</span> 

<span class="branch" 
id="brn_CUSTOM"> 

<img src="icons/card.gif"><a 
style="text-decoration:none" 
target="content" 

href="cards/customDataCardsFolder/
customDataCard1.html">Custom 1</
a><br> 

<img src="icons/card.gif"><a 
style="text-decoration:none" 
target="content" 

href="cards/customDataCardsFolder/
customDataCard2.html">Custom 2</
a><br>

</span> 

custom data cards section You can add the custom data cards section
anywhere in the <body> element of the file.

Configure time analysis

You can perform time analysis in the Process Planning for BTO/BTS/CTO and Process Planning for ETO
workspaces.

Configure time analysis
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Note
You must install the MTM Data card to configure time analysis for your workspace.

Perform this procedure on the Teamcenter rich client.

1. Log on to the Teamcenter rich client.

2. On the Teamcenter server, browse to where you pasted the MTMDataCard folder during the install or
update, such as C:\Program Files\Siemens\MTMDataCard.

3. In Teamcenter, choose Edit → Options  and select the Search tab at the bottom.

4. In the Options dialog box, click Create New Preference .

5. For the Name, type EP_MTMDataCardPaths.

6. Set the following:

Protection Scope = Site

Category = General

7. For the Description, type This is the path to the <Workspace name> data card.

8. For the Value, type the location where you stored the data card.

Example
C:\Program Files\Siemens\MTMDataCard\index.html

9. Click Save .

10. From the Navigation pane, choose Manufacturing Process Planner .

11. In the Manufacturing Process Planner toolbar, choose Add .

The data card is imported into Teamcenter.

12. Delete the *mtmdatacardutility*.jar file from the TC_ROOT\portal\plugins folder.

Note
You no longer need this command shown in Teamcenter.

13. Reindex your site. See the Active Workspace Deployment documentation to install and configure this
mechanism.

Entries from the data card can now be used in your workspace for time analysis.

Configure time analysis

Easy Plan 2412 ─ Deployment and Administration 10-19
Unpublished work. © 2024 Siemens Software Version Teamcenter 2412



Time unit properties

Default time unit measurements are supported in the Process Planning for BTO/BTS/CTO and Process
Planning for ETO workspaces.

Note
If you need to use runtime properties to retrieve times of operations and the properties must consider
the currently set time (not just the internal database time), then use properties with the suffix
Converted attached to the name.

These properties consider the value currently set (for example, 1), then calculate and apply the value to
the selected time unit (for example, minutes).

Example
If user A sets the units to minutes and user B sets the units to seconds, user A will see 1 minute and user
B will see 60 seconds.

Use the following properties to view default time information:

• Mfg0AllocatedTimeConverted – View the allocated time for an operation considering the time that is
currently set.

• Mfg0EstimatedTimeConverted – View the estimated time for operations, considering the time that is
currently set.

Time analysis preferences

You can use these preferences to manage time analysis and time analysis priorities in your environment.

Time system preferences

You can use the EP_TimeAnalysisMode preference to define time detailing for operations in your
environment.

Valid values for this preference are:

Note
The default value for this preference is ACTIVITIES.

The default value for this preference is ACTIVITIES.

• ACTIVITIES—defines if time detailing is done using Teamcenter activities and data card activities.

Time unit properties
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• CLASSIC_ACTIVITIES—defines that activities are automatically created per process or operation.
Activities cannot be created manually; they can only be authored.

• CLASSIC_ACTIVITIES_CREATE—defines that activities are manually created and authored in
Teamcenter, per operation.

• TICON—defines TICON integration with the MTM data card as the time system used in your
environment.

Note
You must also complete the task to Add the MTM data card to Teamcenter Easy Plan when you use
the ACTIVITIES value for this preference

Time analysis priorities

You can use the EP_TimeAnalysisPropForOperationTime preference to create custom time properties
specific to your environment. You can use the EP_TimeAnalysisPropForOperationTime preference to
define:

• How to calculate line balancing time.

• Which time elements to consider for operations.

• The priority order of time elements for operations.

Default values for this preference are Mfg0allocated_time and Mfg0EstimatedTime. You can create
custom properties using the format: <element name>, such as ClockTime.

Tip
Define all custom properties before you modify the EP_TimeAnalysisPropForOperationTime
preference.

Valid values for this preference are numeric properties that represent time units, for example, the number
of seconds or minutes. The operation time is set according to the property order, from lowest to highest
numeral. Process Planning for BTO/BTS/CTO skips properties with a value of 0 and considers the next
element for time analysis.

For example, if Mfg0allocated_time has a value of 0 and Mfg0EstimatedTime has a value of >0, the
operation time is calculated using estimated time.

Configure time study preferences

You can use these preferences to manage time study preferences in your environment.

Configure time study preferences
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You must add each preference you use to the AWC_Startup_preference in the Teamcenter rich client.
See the Preferences section in the Active Workspace Administration documentation for a description of
preferences and how to set them.

• EP_OperationPageActivitiesTabActivitiesGridAreaColumnConfiguration—controls the column
configuration of the Time Management panel.

• EP_TimeStudiesTableColumnConfiguration—controls the column configuration of the Time Study
table on the Process Planning page. This table shows the properties of the object revision, and not
those of the BOM line.

• EP_TimeStudyTreeColumnConfiguration—controls the column configuration of the time study tree on
the Time Study page.

• EP_TimeStudyPlantBopColumnConfiguration—controls the column configuration of the plant BOP
tree on the Time Study page.

• IsolatedStudySyncPublish—controls the closure rule that is used to search the objects that are used for
publishing.

• Mfg0MEPlantBOP.Mfg0TimeStudy.CopyPasteTemplate—controls what data is created in a time study.

• StudyPlanningTimeBasedPublishRule—controls what information is published from the Planning Time
Study to the plant BOP.

Define estimated activity times for operations

In Process Planning for BTO/BTS/CTO and Process Planning for ETO, you can use the
EP_ActivitiesColumnConfiguration preference to configure the properties that display in the Time
Management Activities table. You can add properties for operations and activities to the table.

The manufacturing engineer uses the Time Management Activities table to define time estimates for
activities during process planning.

The EP_ActivitiesColumnConfiguration preference accepts multiple string values delimited by colons (:)
in the following format: <identifier>:<value>.

By default, the following values are defined:

• Mfg0BvrOperation.bl_rev_object_name

• Mfg0BvrOperation.bl_sequence_no

• CfgActivityLine.object_string

• CfgActivityLine.al_activity_work_time

Define estimated activity times for operations
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Configure Electronic Work Instructions

For instructions about configuring this workspace, see the Electronic Work Instructions Deployment
documentation available on the Support Center.

Configure Manufacturing-BOM Manager

Manufacturing-BOM Manager uses these preferences, which are defined in Manufacturing Process Planner,
for configuration:

• The MEAlignedPropertiesList preference allows engineering bill of materials (EBOM) parts to be
assigned to a manufacturing BOM (MBOM) with the Assign Parts Selected in EBOM command. You can
configure the item properties that are carried over to the MBOM upon assignment. See the Teamcenter
Manufacturing Process Planner documentation on the Support Center for preference details.

• The MBMEnableStructureSearch preference allows end users to search for parts and assemblies in
an engineering bill of materials (EBOM) or a manufacturing bill of materials (MBOM). To activate
the Find command in the EBOM-MBOM Alignment window and enable structure searches in
Manufacturing-BOM Manager, you must add the MBMEnableStructureSearch preference to the
AWC_Startup_preference in Teamcenter.

• The MEIdGenerationPropertySetting and MEIdGenerationOnAssignEnabled preferences ensure that
in-context IDs (IDICs) and smart IDIC configuration are honored for parts between the EBOM and MBOM.
See the Administering Manufacturing Planning documentation on the Support Center for preference
details.

• The MEEffectivityAssignmentMode and MEAlignedPropertiesList preferences allow for occurrence
effectivity in the EBOM to carry over to the MBOM. If the parent of a line in the EBOM that is getting
assigned to the MBOM has a occurrence effectivity applied, that effectivity is carried over to the MBOM.
See the Administering Manufacturing Planning documentation on the Support Center for preference
details.

• The Rollup_Variant_Feature and MEAlignedPropertiesList preferences allow for variant formulas in
the EBOM to carry over to the MBOM. If the parent of a line in the EBOM that is getting assigned
to the MBOM has a variant formula applied, that formula is carried over to the MBOM. See the
Teamcenter Manufacturing Process Planner and Administering Manufacturing Planning documentation
on the Support Center for preference details.

Configure Next Generation Planning

For instructions about configuring this workspace, see the Next Generation Planning Deployment
documentation available on the Support Center.

Configure Electronic Work Instructions
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Configuring Process Planning for BTO/BTS/CTO

Cloning rules for objects

You must add each of the preferences you use to the AWC_Startup_preference in the Teamcenter rich
client. See the Preferences section in the Active Workspace Administration documentation for a description
of preferences and how to set them.

Note
Starting in version 2406, the EP_BOP.Template preference is deprecated. This preference is replaced by
the Process.Template preference.

• EP_ShowCloneIndication—allows users to identify the source of cloned objects so that changes can be
propagated with a full traceability view during cloning. Set this preference value to true to enable the
clone indication feature.

• EP_CloningSupportedProcessTypes—determines whether consumed parts and assigned resources are
carried forward to the new plant Bill of Process (BOP) when a new plant bill of process (BOP) is created
by cloning an existing plant BOP.

By default, cloning rules ignore consumed parts and assigned resources from the existing plant BOP.

The default value for this preference is Process.Template.Mapping_Consume. You must set this
preference and add it to the AWC_Startup_preference in the Teamcenter rich client before this feature
is enabled.

• EP_PlanningForSmallProduct—allows users to clone a BOP for a full product and modify it to use
in small product mode. Set this value to true to enable this feature. In addition, you must add the
EP_PlanningForSmallProduct and Process.Template preferences to the AWC_Startup_preference in
the Teamcenter rich client.

• MECreateIdInContextforAssignedchildlines—defines the level of in-context IDs (IDICs) data that is
copied when you clone assembly objects in context . The protection scope for this preference is USER.
The valid value for this preference is an integer, which defines how many levels of IDICs are cloned in an
assembly. For example, to copy three levels of IDICs for an in-context assembly, set this preference to 3.

• MEProcess.MEProcess.PasteDuplicateTemplate—allows users to clone existing processes from the
same or a different work package.

This preference supports users working in a classic BOP on the Process Planning page.

◦ To use this preference in a product BOP, set the value to
MEProductBOP.MEProductBOP.PasteDuplicateTemplate.

◦ To use this preference in a plant BOP, set the value to
Mfg0MEPlantBOP.Mfg0MEPlantBOP.PasteDuplicateTemplate.

• Process.Template—defines which cloning rule process template is used to clone items in a process
structure. This preference is passed as a string property.
Values for this preference are:

Configuring Process Planning for BTO/BTS/CTO
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◦ Process.Template.Mapping_Consume—clones the existing process and maps all objects consumed
in the original process into the cloned process.

◦ Process.Template.Referencing_Consume—clones the existing process and references the objects
consumed by the cloned process. Parts and revision IDs in the cloned process are identical to the parts
and revision IDs in the original structure.

◦ Process.Template.Ignoring_Consume—clones the existing process and does not map or reference
any objects consumed in the original process.

• TC_CLONE_CREATE_BASED_ON—defines how the Based On relation is created between masters and
clones in the Manufacturing Process Planner (MPP) application. For this specific relation, the feature
handles propagation. If the preference value is true, the Based On relation between the clone and
original objects is created for objects in all levels.

The default value for this preference is false. Set this preference value to true to enable the clone
indication feature.

Collaboration context properties

You can change properties on the CCObject to display the master collaboration context (CC) for an
alternative CC, or to display alternative CCs for a master CC.

Note
These are existing properties in the default, out-of-the-box stylesheet of a CC. You can add them to your
stylesheet, or any other customizations you create in your environment:

• mbc0masterCC shows the master CC for a given CC

• mbc0alternatives shows the alternative CCs for a master CC

Structures

Configuring structures with effectivity

You can use the EP_EffectivityMode preference to set the effectivity type, which the planner uses to
configure structures in Process Planning for BTO/BTS/CTO and Process Planning for ETO. The default value is
UNIT. You can also set it to DATE, to work with date-based effectivity.

Configuring structures with a different effectivity

You must configure the EP_WorkareaPopupTableColumnConfigurationpreference before end users can
use this feature.

End users can define a structure configuration on the EBOM-MBOM alignment, BOE Authoring, or plant
BOP pages.

Collaboration context properties
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Note
You cannot define a structure by date range on the EBOM-MBOM alignment page, because Active
Workspace does not support it. This feature will be fully supported in a later release.

Configuring structures with variants

Process Planning for BTO/BTS/CTO supports classic variants and Product Configurator variants. By default,
Process Planning for BTO/BTS/CTO is set to use Product Configurator variants. To use classic variants, you
set the Teamcenter PSEVariantsMode preference to legacy.

Note
To use Product Configurator variants, you must be in Teamcenter 11.5 or later.

On the station Balancing and Operation tabs, operations are displayed according to the product variants
they belong to (or their variant applicability). Applicability of an operation to a product variant is based on
whether an operation applies to a specific product variant.

To configure an operation out based on the variant applicability of its consumed parts, you configure it
using these Teamcenter preferences:

• typeAndRuleForProcessConfiguration

• controllingOccsForProcessConfiguration

By default, only operations with the base MEOP type and part assignment of type MEConsumed
are considered for configuring out. If any other operation subtypes and occurrence types should be
considered, you must modify these preferences. See the Teamcenter Manufacturing Process Planner or
Teamcenter Environment Variables Reference documentation for details.

Line balancing

You can use line balancing preferences to manage object properties in the Line Balancing page.

Note
You must add each preference you use to the AWC_Startup_preference in the Teamcenter rich client.

See the Preferences section in the Active Workspace Administration documentation for a description of
preferences and how to set them.

Line Balancing dashboard preferences

Line balancing
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The EP_LineBalancingDashboardInformation preference defines which tiles are displayed in the Line
Balancing dashboard.

Some of the informational tiles are displayed by default, and cannot be removed. You can add the listed
optional values to the EP_LineBalancingDashboardInformation preference to display more tiles in the
Line Balancing dashboard.

Value Description Default or optional tile

taktTime Displays the takt time for the assembly line. Default

cycleTime Displays the average time it takes to finish one unit
of production.

Default

waitTime Displays the amount of time an item waits for
processing or inspection, or to move to the next
operation on the assembly line.

Default

unassignedTime Displays the amount of time a process resource is
unassigned on the assembly line.

Default

humanResources Displays the number of human resources on the
assembly line.

Default

cobotResources Displays the number of cobot resources on the
assembly line.

Optional

humanResourcesAndBTI Displays the number of human resources and the
balance time index (BTI) for human resources.

Optional

cobotResourcesAndBTI Displays the number of cobot resources and the BTI
for cobot resources.

Optional

overallEquipmentEffectiv
eness

Displays overall equipment effectiveness. Optional

piecesPerShift Displays the rate at which completed products are
produced on the assembly line.

Optional

piecesPerPersonPerHour Displays the calculation for parts per person, per
hour, produced on the assembly line.

Optional

allowance Displays the extra time that is added to a schedule
for delays, unexpected events, or additional tasks.
This value is displayed in a percentage.

Optional

Manufacturing time preferences

• The EP_LineBalancingUseBottleneckTime preference defines whether the line balancing calculation is
displayed in takt time or in bottleneck mode. The default value is false. Set this preference to true to
display the calculation in bottleneck mode.

Line balancing
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• The EP_TaktTimeForProductionProgramDefinition preference controls whether to display the takt
time chip based on the production line, or based on the product variant in the production program
definition (the takt time is defined by the production program definition). The takt time chip is displayed
in the Line Balancing dashboard. The default value for this preference is Line.

To display the takt time chip based on the product variant, set the default value for this preference to
ProductionProgramDefinition.

• The EP_LineBalancingProcessResourceTypesForTotalWaitTime preference calculates the total wait
time for all process resource types in the preference value. The default value for this preference is
human. You can set the following valid values for this preference:

◦ Human

◦ Cobot

• The EP_LineBalancingCycleTimeIgnoreExternal preference defines whether to ignore or include
external operations when computing the cycle time during line balancing. The default value for this
preference is false, which means that external operations are included when computing cycle time. Set
this value to true to ignore external operations when computing cycle time.

Process resource preferences

• The EP_LineBalancingProcessResourceUtilization preference controls whether process resource
utilization displays as a nominal value or a percentage of takt time in the Line Balancing page.

The default value for this preference is false, which displays utilization as a nominal value. Set this
preference to true to display utilization as a percentage.

• The EP_ProcessResourceCapacityValues preference controls the values in the user interface to set
operator capacity. The default values are 50 and 100. You can customize these values for your
environment.

• The EP_LineBalancingProcessResourcesTypesForOverview preference defines which process resource
types are displayed in the Overview tab. You can set the following values for this preference:

◦ Human

◦ Cobot

◦ Machine

Note
If the EP_LineBalancingProcessResourcesTypesForOverview preference does not exist in your
environment, or the values for the preference are empty, all of the process resource types display
in the Overview tab.

• The EP_LineBalancingProcessResourcesTypesForUtilization preference defines which process
resource types are in the utilization list. The user can then add a value range for each process resource
type. You can set the following values for this preference:

◦ ◊ Human

◊ Cobot

Line balancing
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◊ Machine

Note
If the EP_LineBalancingProcessResourcesTypesForUtilization preference does not exist in your
environment, or the values for the preference are empty, all process resource types display in the
utilization list.

• The EP_useProcessResource preference allows planners to monitor and manage process resource
interactions, which helps reduce resource wait time in production plans.

Note
The process resource interaction feature is active by default. If your environment does not use process
resources, set the EP_useProcessResource preference to false to hide this feature.

Process station preferences

The EP_StationDisplayProperty preference determines the station property that displays in the station tile
in the Line Balancing page. You can customize this value for your environment.

The default value is bl_rev_object_name, where object_name refers to the revision name. This
preference is passed as a string property, and it must be a single value.

To display a different property, change the value for that property to object_string.

Note
If this preference value is missing or incorrect, Teamcenter Easy Plan displays the bl_rev_object_name
value in the station tile.

Product variant preferences

• The EP_LineBalancingAllowVariantConfigurationWithProductVariantFiltering preference allows
users to configure a plant bill of process (BOP) tree with variant rules or to load a tree that is
preconfigured with variant rules. Then you can filter the plant BOP tree according to product variants.

The default value is false. Set this value to true to enable this feature.

Note
This preference applies only in the Line Balancing page.

• The EP_LineBalancingProductVariantsFilterValues preference controls whether to show or hide the
Weighted and Maximum product variants in the Line Balancing Product Variant list. The default
values for this preference are WEIGHTED:true and MAXIMUM:true. To hide the Weighted and
Maximum product variants, set the preference values to WEIGHTED:false and MAXIMUM:false.

Line balancing
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Process Planning page role preference

The EP_ProcessPlanningViewModeForRoleME preference defines role configuration for the Process
Planning page.

The default value for this preference is false, which leaves the role set for industrial engineers. Set the
value of the preference to true to configure the role for manufacturing engineers.

The Process Planning page displays data for each role as follows:

• Industrial Engineers—Data in the Process Planning page displays process resources and the assigned
operations under them.

• Manufacturing Engineers—Data in the Process Planning page displays directly under process stations,
and process resources do not display on the page.

Stations

You can use these preferences to manage station properties in your environment.

The EP_StationDisplayProperty preference determines the station property that displays in the station tile
on the line balancing page. You can customize this value for your environment.

The default value is bl_rev_object_name, where object_name refers to the revision name. This
preference is passed as a string property, and it must be a single value.

To display a different property, change the value for that property to object_string.

Note
If this preference value is missing or incorrect, Process Planning for BTO/BTS/CTO displays the
bl_rev_object_name value in the station tile.

Configuring twin station sync behavior

You can use these preferences to manage sync behavior between the plant bill of process (BOP) and the
BOE when one of these objects is created as a twin station in your environment.

• The MEBOPToBOEObjectTypeMap preference supports the BOEPlantBOPTypeAndPropertyMap XML
dataset, which is used to create a bill of equipment (BOE) structure from a plant bill of process (BOP) or
vice versa.

• The EP_RemoveObsoleteOnSyncTwin preference determines whether to remove obsolete elements
during a twin station sync.

The default value is false.

Stations
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Bill of Equipment authoring

You can use these preferences to improve the user experience while authoring bills of equipment (BOE) in
your environment.

• The AWC_MEPlantRevision.SUMMARYRENDERING preference registers the summary stylesheet for
Plant Revision objects in the ACE page.

The default value is MEWorkareaRevSummary.

• The
AWC_MEPlantRevision.showObjectLocation.OccurrenceManagementSubLocation.SUMMARYREND
ERING preference registers the summary stylesheet for these Plant Revision objects in the ACE page:

◦ ShowObject Location

◦ OccurrenceManagement SubLocation

The default value is MEWorkareaRevSummary.

• The AWC_MEPlantRevision.showObjectLocation.SUMMARYRENDERING preference registers the
summary stylesheet for the Plant Revision ShowObject Location object in the ACE page.

The default value is Awb0ItemRevSummaryForShowObjectLocation.

Operations

You can use these preferences to manage operations in your environment.

Operation types

The EP_OperationsTypes preference defines operation types for each operation-persistent type, including
sub-types. This preference helps differentiate between human and machine operations.

Type Default value

None MEOP

Human Mbc0HumanOp

Machine Mbc0MachineOp

The format of each value is OperationClass:TypeEnum. For example: Mbc0HumanOp:Human.

Operation capabilities

End users can now set capabilities for operations. To enable operation capabilities, you must add the
CLS_is_presentation_hierarchy_active preference to the AWC_Startup_preference in Teamcenter.

Bill of Equipment authoring
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Note
Each operation can have multiple capabilities.

Operation capabilities are classified.

MBOM items

The EP_ProductScopeTabTreeGridColumnConfiguration preference controls column configuration of
data on the Parts subtab of the Planning tab when end users assign items from the manufacturing
bill of materials (MBOM) to the plant bill of process (BOP).

The default value is ImanItemBOPLine.object_string, which refers to the revision name.

To display a different property, change the value for that property to object_string.

Process resources

You can use these preferences to manage process resources in your environment.

• The EP_LineBalancingProcessResourceUtilization preference controls whether process resource
utilization displays as a nominal value or a percentage of takt time in the Line Balancing page.

The default value for this preference is false, which displays utilization as a nominal value. Set this
preference to true to display utilization as a percentage.

• The EP_ProcessResourceCapacityValues preference controls the values in the user interface to set
operator capacity. The default values are 50 and 100. You can customize these values for your
environment.

• The EP_useProcessResource preference allows planners to monitor and manage process resource
interactions, which helps reduce resource wait time in production plans.

Note
The process resource interaction feature is active by default. If your environment does not use process
resources, set the EP_useProcessResource preference to false to hide this feature.

Configure taxonomy for classification

MBOM items
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Before end users can use taxonomy for classification, you must add the
CLS_is_presentation_hierarchy_active preference to the AWC_Startup_preference in the Teamcenter
rich client.

Note
If you do not add this preference to the AWC_Startup_preference and end users open the product bill
of process (BOP) page, the following error message may be displayed.

Configuring Teamcenter Manufacturing Access

Hosting preferences

Before you can use Teamcenter Manufacturing Access, you must configure the correct hosting preferences
for your environment.

Caution
Starting in version 6.2, the ActiveWorkspaceHosting.PS.URL is deprecated.

If you use the ActiveWorkspaceHosting.PS.URL, your end users cannot connect to NX or use the MFG
Search feature in Process Simulate.

Study Manager (TcMA) hosting preferences

To connect to Study Manager
(Teamcenter Manufacturing
Access) from...

Configure this hosting
preference

Additional information (if
applicable)

Teamcenter rich client TCMAccessHosting.RAC.URL For a server named hostname
on port 3000, type: http://
localhost:3000.

Process Simulate and NX TCMAHosting.PS.URL The format for
this preference is http://
<serverhost>:<gatewayport>.

Plant Simulation ActiveWorkspaceHosting.PLAN
T.URL
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Client-side preferences

You can modify defaults for client-side preferences. However, end users can override some default
preferences in Teamcenter Manufacturing Access. For example, end users can choose which columns
are displayed in some dialog boxes, and the order in which those columns display.

Tip
Correctly spelling property names is critical. If you do not know how to spell a property name, open
a Teamcenter Manufacturing Access dialog box that contains the property and verify the value of the
related preference.

• CCObject.CellProperties—Lists property name and values to display in the object cell for a
collaboration context object. The format for a value of this property is <property internal name>.

• Default_StructureContext_Type—Specifies which type of structure context is the default item
type for a study. You can add multiple lines to this preference as string values in the
<item_type>:<StructureContext_type> format.

Note
To enable Study Manager, you must replace the existing line for an Mfg0MEStudy item type with this
line:Mfg0MEStudy:Mfg0StudyStructureContext.

Valid values for this preference are:

Process:MEProcessContext

OP:MEProcessContext

WorkArea:MEPlantContext Item:MEProductContext

MEGenericBOP:MEProcessContext MEProductBOP:MEProcessContext

Mes0MESTXLibrary:MEProcessContext

Mfg0MEProdPrgCol:Mfg0MEProdPrgContext

Mfg0MEStudy:Mfg0StudyStructureContext

• TCMA_EditStudyProcessColumnProperties—Lists columns available in the Process area of the Edit
Study dialog box.

• TCMA_EditStudyPlantGrid_Column—Lists the column properties overridden by the end user in the
Plant area of the Edit Study dialog box.

• TCMA_EditStudyPlantColumnProperties—Lists columns available in the Plant area of the Edit Study
dialog box. End users can configure column display in the user interface.

• TCMA_StudyElementsColumnProperties—Lists columns available in the Elements area of the Edit
Study dialog box.

Client-side preferences
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• TCMA_StudyMgrStudyGrid_Column—Lists default columns shown in the Study Manger view. The
format for a value of this property is <object type>.<property internal name>.<column width>.

• TCMA_StudyMgrStudyColumnProperties—Filters the list of properties shown in the Columns
Configuration dialog box in Study Manager. The format for a value of this property is <object
type>.<property internal name>.

Note
The study revision type inherits all properties from the item revision type. This properties list is a
subset of the total properties of the study object, and is used to filter which properties can be shown
in the Study Manager view. If this preference is empty, all properties of the study object can be
shown.

• TCMA_StudySavedColumnConfigurations—Saves the column configuration when an end user
overrides the default Study Manager column layout. The TCMA_StudySavedColumnConfigurations
preference saves and populates the column configuration each time the user launches Teamcenter
Manufacturing Access. This preference saves one configuration option per user. The default value for
this preference is False.

• TCMA_CreateSubtypesForType_Mfg0MEStudy—Lists subtypes to show when the planner creates a
study.

• TC_Set_Current_Project—Supports default project settings for end users. The default value for this
preference is: True.

After you set the preference, use the BMIDE package to enable and deploy the autoAssignToProject
extension and propagation rules. The extension and propagation rules ensure that when a planner
creates a study or an object under a study, all created objects are automatically assigned to the selected
project. See Configure your Business data model in BMIDE in the Teamcenter Help collection for more
information about using the BMIDE package.

Cloning preferences

Use this preference to configure cloning in your environment.

The MESetPhysicalAttachmentInContextOfCommonParent preference defines how mount and attach
relations are stored at the robot package level.

Example
Typically, a weld gun is mounted on a robot and the robot is attached to the base plate. As a simulation
or layout engineer, you can now retain the mount and attachment relations when you clone the robot
package.

Valid values for this preference are:

• True—Stores the mount and attach relations at the least parent level.

• False—Stores the mount and attach relations at the plant level.

Cloning preferences
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The default value for this preference is false.

Manufacturing features search preferences

Use these preferences to configure manufacturing feature searches in your environment.

• TCMA_MFGSearch_WeldTypes—Defines supported types for a weld category search. This preference
controls the content in the Type list of values (LOV) during a Discrete operation query.

Default values include

Resistance Spot Arc Spot

Dollop Clinch

Weld Nut Weld Stud

Rivet Sonic

Laser Spot

You can modify this preference to customize the LOV for your environment.

• TCMA_MFGSearchResult_Column—Lists default columns shown in the Mfg Search dialog box search
results. The format for a value of this property is <object type>.<property internal name>.<column
width>.

• The TCMA_MFGSearchResult_ConfigurationColumn preference controls the list of properties that
are available in the Column configuration for manufacturing features search results. You can remove
properties from this list to customize it for your environment.

Resource search preferences

Use these preferences to configure resource searches in your environment.

TCMA_Resource_Types—Controls the resource types that Teamcenter Manufacturing Access displays in
the resources browser view. Valid values are object type names. The default value is:

Mfg0MEResourceRevision

The system shows all objects of type Mfg0MEResourceRevision and its subtypes in the view.

Note
You can add multiple resource search preference types.

Manufacturing features search preferences
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If you have classified MEResources instead of MEResourceRevsions, you can add Mfg0MEResource. If
your environment requires custom types, you can also add them in this preference.

Study-related preferences

You can configure these study preferences for your environment.

• CCObject_DefaultChildProperties—Specifies a list of properties that can be used as children for the
study type.

By default, Mfg0CCStudyRel is added to the list to show all studies in the collaboration context tree and
in My Teamcenter.

Note
To improve performance and hide the study objects attached to the collaboration context, remove the
Mfg0CCStudyRel relation from this preference.

• CO_FOR_EDIT—Enables the check out feature in Study Manager so that end users can verify that no
one else is editing a study before the study gets loaded. Checking out a study prevents anyone else
from modifying the data. Set the preference value to True, and add the CO_FOR_EDIT preference to the
AWC_Startup_preference in the Teamcenter rich client.

• Study_allow_process_context_rev_rule—Indicates whether the Study Manager is enabled. You can
use this preference to apply a revision rule to the collaboration context structure.

Valid values for this preference are:

◦ True—Applies the revision rule from the process context in the collaboration context structure. True
is the default value for this preference.

◦ False—Applies the default revision rule, which is read from the TC_config_rule_name preference.

• TCMA_CreateSubtypesForType_Mfg0MEStudy—Lists subtypes to show when creating a study.

• TCMA_EditStudyProcessGrid_Column—Lists the column properties overridden by the end user in the
Process table of the Edit Study dialog box. End users can configure column display in the user interface.
The format for a value of this preference is <object type>.<property internal name>.<column width>.

• TCMA_EnableStructureSearch—Enables end users to search process and plant structures in the Study
Manager Edit page. The default value for this preference is True.

• TCMA_StudyElementsGrid_Column—Lists the column properties overridden by the end user in the
Study Elements table in the Edit Study dialog box. End users can configure column display in
the user interface. The format for a value of this preference is <object type>.<property internal
name>.<column width>.

• TC_Set_Current_Project—Supports default project settings for end users. The default value for this
preference is True.

Study-related preferences
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Note
After you set the TC_Set_Current_Project preference, use the BMIDE package to enable and deploy
the autoAssignToProject extension and propagation rules. The extension and propagation rules ensure
that when a planner creates a study or an object under a study, all created objects are automatically
assigned to the selected project. See Configure your Business data model in BMIDE in the Teamcenter
Help collection for more information about using the BMIDE package.

Study Manager preferences

To use the Teamcenter Manufacturing Access Study Manager, configure these preferences in a Teamcenter
rich client.

• MEWorkflowsToAddAndRemoveStudiesFromBriefcaseExport—Defines the workflows Teamcenter
Manufacturing Access uses to add and remove study objects during a briefcase export of a collaboration
context. The format for a value of this property is Approved.<workflow_add_name>:Remove
Approved.<workflow_remove_name>. These workflows add and remove the maturity statuses
specified in the MEStudyMaturityStatusforBriefcaseExport preference.

• MEStudyMaturityStatusforBriefcaseExport—Defines the study object maturity statuses used during a
briefcase export of a collaboration context. The default value is Approved, which means that all the
studies in a collaboration context with a status of Approved are exported.

• TCMA_EnableVariantOnStudyManager—Enables the variants feature in Study Manager. Set the
preference value to true to enable the variants feature. The default value for this preference is false.

Note
The variants feature in Study Manager is supported on Process Simulate version 2502 and later.

The variants feature in Study Manager only supports Product Configurator variants. You cannot use
this feature with classic variants.

Classification search

Before end users can perform a Classification search, you must install and configure the Classification
server.

See Configure search for traditional Classification in the Active Workspace help for details about installing
and configuring this search mechanism.

Use the TCMA_ClassificationSearch_URLParams preference to specify which parameters to append onto
a new classification search URL. The format for this preference is parameterName.value.

Study Manager preferences
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Study conversion workflow

If end users have legacy studies, those studies must be converted via workflow before Teamcenter
Manufacturing Access can read them.

You can configure the Attach_studies_to_cc workflow for your end users. This workflow connects legacy
studies  to a collaboration context object so they can be viewed in Teamcenter Manufacturing Access
and Teamcenter Study Manager.

Each converted study is placed in a new structure context object within the collaboration context. The
Mfg0CCStudyRel relation creates the link between studies and the structure context object.

You can change the following values when you configure the workflow.

• If the user does not specify a configuration context, the TCA0_attach_studies_to_cc action handler
uses the value of the -revision rule argument. By default, this argument is set to Latest Working.

• By default, the workflow creates one configuration context for each study structure context. To share a
configuration context between multiple study structure contexts, set the -config context argument to a
value of share.

Ensure that the configuration context of shared studies in a CC matches that of the
BOP

In Teamcenter Manufacturing Access, you can ensure that shared studies and the classic or plant bill
of process (BOP) share the same configuration context. This is vital especially when you save the study
as a new configuration context (CC) so that the BOP and shared studies in the new CC have the same
configuration context.

Note
This option does not apply to isolated studies.

1. Make sure you or your administrator have set the value of the preference
MEShareConfigurationContextToStudy to Mfg0MEShdStudy.

2. Load your working CC to Manufacturing Process Planner and configure the configuration context of
the BOP to a desired revision.

3. Select File → Collaboration Context → Save as New Collaboration Context.

4. In the Save as New Collaboration Context dialog box, type a name for your new CC, and from the
Include Studies list, select All to include all shared studies, or Released to include only released
studies.

5. Save the shared study and load the new CC to Manufacturing Process Planner.

Study conversion workflow
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6. In the Collaboration Context Tree dialog box, right-click the top line of the shared study CC and
choose Open with → Study Manager.

The shared studies have the same configuration context as the BOP.

Configuring Process Planning for ETO

Relation types

You can use these preferences to configure relation types in your environment.

• The EWI_InstructionRelationsInfo preference allows Process Planning for ETO to present work
instructions as HTML. You must set this preference to Epw0WIRelation to make this feature available.

This preference supports multiple values, and the order of the values defines the sequence in which
Process Planning for ETO searches for work instructions to display. If the first value points to a work
instruction, it is presented and no other values are considered. If the first value does not point to a work
instruction, the preference checks remaining values and presents the first work instruction as HTML.

• The WI_ImageRelationsInfo preference defines the properties and relations data displayed in the
Process Planning for ETO Image viewer.

The format for this preference is <property/relation name>[:<type names>. Property or relation is
the name of the step object or sub-type of the bill of materials (BOM) line. The type name is a comma-
separated list of internal type names to display for the secondary object of the property or relation. This
argument is optional. If type names are not provided, all secondary object information is displayed.

• The MEAssignCustomizedOccurrenceType preference defines the occurrence types that are displayed
by default in the Assigned Resources table. The end user can set an occurrence type for one or multiple
resources, and those resources do not have to be of the same type. For example, the user could set an
occurrence type for Robot and Conveyer.

Populate or update PMI using a Teamcenter utility

You can use the Teamcenter utility populate_pmis_info.exe on a machine with NX and Teamcenter
installed to populate or update product manufacturing information (PMI) objects in your Teamcenter Easy
Plan database for use in Process Planning for ETO.

Another option is to use the preference MciImportPMIWorkflowName with a value of PMI
Characteristics Extractor to populate objects into Teamcenter whenever a CAD model is saved
from NX. However, if you don’t use this preference, then use populate_pmis_info.exe.

Procedure

1. In NX, modify the PMI information associated with the JT files that you want to add or update in
Process Planning for ETO.

Configuring Process Planning for ETO
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2. Open a Teamcenter prompt at the server's root location.

Example
C:\Siemens\Teamcenterx\tcroot

3. Run the utility populate_pmis_info.exe and specify the following:

• The main structure root ID, which is the top node assembly ID

• The item ID, which is the ID of the subassembly in which PMIs to be added or updated are present

Example
This command populates or updates PMI objects in this root and subassembly structure in the Work
Instructions Authoring page of Process Planning for ETO:

populate_pmis_info.exe -u=me -p=mypassword -g=dba -root=001110 
-itemid=001116

Tip
For help with specific utility parameters, at the prompt, type populate_pmis_info.exe -h.

Compound operation preferences

Unlike a standard operation, which can define only a single activity, a compound operation can contain
multiple execution steps that break that operation into specific steps to be executed. End users employ
compound operations in the same way as standard operations in a work flow or work instructions
authoring process. For example, for each compound operation, they can edit summary properties, assign
documents and other attachments, capture and save images, set effectivity, and validate occurrence
effectivity.

Compound operation preferences

Easy Plan 2412 ─ Deployment and Administration 10-41
Unpublished work. © 2024 Siemens Software Version Teamcenter 2412



Compound operations and execution steps can include custom object types. Preferences include the
following.

• EP_CreateSubtypesForType_Mfg0MECompOP defines the types of compound operation available
when users create compound operations (EP_CreateSubtypesForType_ + value). Default:
Mfg0MECompOP.

• EP_CreateSubtypesForType_Mfg0MEStep defines the types of execution steps available for each
compound operation (EP_CreateSubtypesForType_ + value). Default: Mfg0MEStep.

Viewer preferences

You can use these preferences to configure the viewer in your environment.

Notes formatting settings

The WI_SavedPresets preference defines formatting options for notes that display in the graphics viewer.
This preference is added by default when Teamcenter Easy Plan is installed on the Teamcenter server.

This preference accepts multiple string values delimited by colons (:) in the following format:

<identifier>:<value>

The default protection scope for this preference is ROLE and the category is EPWI.

By default, the following values are defined:

• "color": "#0000ff", "font-size": "30px"

• "color": "#FF0000", "font-family": "Courier New"

• "color": "#008000"

Note
You can add values and customize notes for your environment.

Product View settings

The TCVIS_PV_CAPTURE_PRECISE preference defines whether all children under an operation are
considered when creating a Product View. When this preference value is set to True, all children below an
operation are captured in the Product View for both precise and non-precise structures. The default value is
True.

Viewer preferences
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Selection color settings

The EP_GraphicsSelectionColor preference defines a custom selection color for end users in the viewer.
This preference requires a single string value. The default protection scope for this preference is SITE and
the category is EasyPlan.

To define this preference, you must begin the string with the characters 0x, and then append the
hexadecimal value for the custom color you want to use. For example, you can use the following
characters to define the preference:

• 0xFF0000 for red

• 0xffffff for white

• 0x0000ff for blue

The default value is 0xFFFF00, for yellow.

Create custom manufacturing validation tests with Teamcenter Easy
Plan

Custom manufacturing validation tests overview

This process includes tasks for people in two roles:

• Teamcenter developers write the test cases.

• Teamcenter administrators set Teamcenter preferences and register the test cases in the environment.

Where applicable, we indicate which role completes a task. Reference information is intended for all
audiences.

Your end users can use Teamcenter Easy Plan and the manufacturing validation tests you create to
verify whether manufacturing processes and operations are ready to be released. If a manufacturing test
validation fails, the end user can resolve any errors before releasing data.

Note
Teamcenter Easy Plan provides a framework for you to create tests specific to your environment.
Teamcenter Easy Plan does not provide complete tests that you can use out-of-the-box in your
environment, but the installation files contain sample validation tests.

You can create, build, install, and verify a custom manufacturing validation test library that is executable
from the EasyPlan web application.

Create custom manufacturing validation tests with Teamcenter Easy Plan
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Prerequisites

Before you create manufacturing validation tests, verify that your environment meets the requirements
listed here.

Requirement For more details see this documentation

Teamcenter client configured with the Teamcenter
Easy Plan web application, connected to a standard
four-tier Teamcenter environment.

Teamcenter Easy Plan Deployment

The Teamcenter Easy Plan application configured
with at least:

• Work Instructions or Process Planning page.

You can open the Validations command panel
on either of these pages.

• A work package for testing that contains:

◦ Assembly

◦ Bill of Process (BOP)

Teamcenter Easy Plan Process Planning for ETO

Teamcenter Easy Plan Process Planning for
BTO/BTS/CTO

If you need more assistance with these prerequisites, contact Product Lifecycle Management Support or
your Teamcenter customer account team.

Build component requirements

Although you can install the build components on any compatible machine that can run the required build
components, for now we assume the build components are installed on the Teamcenter Server machine.
In addition, we provide details for a Windows server, but you can complete a similar setup for a Linux
server.

The required build components are:

• Teamcenter Server installation

After you install Teamcenter Server, keep the Teamcenter installation kit directories.

• A compatible version of Microsoft Visual Studio or Linux C++ Development Environment.

◦ For Teamcenter 12.4 and its patches this is Microsoft Visual Studio 2017.

Note
For supported compilers, including supported versions of Microsoft Visual Studio, see the Hardware and
Software Certifications knowledge base article on Support Center.

Prerequisites
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Manufacturing validation test components overview

You use these components to create and validate custom manufacturing validation tests:

• EasyPlan Web browser—also referred to as the client machine.

The EasyPlan Web Application requires the client machine.

• Teamcenter Server—install the build components on this machine.

The server-side execution of the manufacturing validation tests requires the Teamcenter Server. The
Teamcenter server can also serve as the build machine for custom manufacturing validation test
libraries. This is a standard four-tier Teamcenter server machine.

• Teamcenter database—install the manufacturing validation test libraries on the same computer where
you install the Teamcenter database.

Note
For convenience, install the build components on the Teamcenter server. You can install these
components on a separate machine, but then you must copy the components to the Teamcenter server.

The build components are:

• Teamcenter server installation

• Either Microsoft C++ Visual Studio or Linux C++ Development Environment

Manufacturing validation test components overview
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Installing and verifying sample validation tests

Install sample validation tests on the Teamcenter server

Note
The Teamcenter administrator performs this task.

Procedure

1. On the Teamcenter server, navigate to the directory where the manufacturing validation test samples
are installed.

For example, $CD_ROOT/additional_applications/mfg_validation_test_sample/samples.

2. Copy the entire directory, and then navigate to a local directory and paste the contents there.

For example, c:/apps/ mfg_validation_test_sample/samples. This is your validation samples directory.

3. Open a Teamcenter command prompt.

4. Build the sample code and in the TC_ROOT\bin folder, use the resulting .dll file.

For more information, see Build customized manufacturing validation tests and Install and verify
customized manufacturing validation tests.

5. Change to the validation samples directory and execute the following command:
mfgValidationTestCallbackInstaller.bat <user> create.

Note
The .bat file is written so that <user>==<passwd>. Update the .bat file if this is not true.

The console displays a Successfully Registered message.

6. Start the Teamcenter Rich Client and log on as an administrator.

7. In Teamcenter, choose Edit → Options, and click the Search tab at the bottom.

8. In the Options dialog box, locate the following preferences:

• MfgValidationTestFramework_Client_EP_ValidationTestTypes

• MfgValidationTestFramework_Client_MBM_ValidationTestTypes

• MfgValidationTestFramework_Client_MBM_ClosureRules

The first preference defines test types for validation checks in the Process panel or tab in the Process
Planning or Work Instructions Authoring pages. The last two preferences define test types and
closure rule names for validation checks in the EBOM-MBOM Alignment page.

Example
MfgValidationTestFramework_Client_MBM_ClosureRules=AccountabilityAll expands a top
assembly line along with assigned child lines.

Installing and verifying sample validation tests
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9. Add the -type argument value from the mfgValidationTestCallbackInstaller.bat file that you just
registered to this preference.

10. Save changes to the preference, and exit out of the Options dialog box.

Run and validate the sample tests with Teamcenter Easy Plan

After you install the sample tests, you can run and validate the tests to verify that they operate correctly in
your environment.

Note
The Teamcenter administrator performs this task. This process works only for classic bill of process (BOP)
structures.

1. Start the Teamcenter Easy Plan application.

2. Search for and open an existing work package and navigate to the High Level Planning page.

3. Expand the structure, select an assembly, and click Work Instructions Authoring.

4. In the Process tab, select a process or operation and in the page toolbar, click Open Validation
Checks .

The Validation Checks panel opens.

5. In the Process panel, select a process or operation to be validated and in the Validation Checks
panel, click Run Validation Checks .

6. Select a line in the Validation Checks table to view additional information in the Details section.

Run and validate the sample tests with Teamcenter Easy Plan
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Note
Information in Details includes the following.

• Test Name—lists the names of tests run on that line.

• Message Type—lists the types of messages generated for the tests.

◦ Info—The test results contain benign information. You do not need to resolve Info message
types.

◦ Error—The test failed. You must resolve all errors for the process or operation before you
release data.

• Message—lists detailed information about the test results. Use this information to resolve any
failed validations.

7. Review and analyze the results, and perform one of the following actions:

• If all validation checks pass, you do not need to perform any further action. The process or
operation is ready for release.

• If one or more validation checks fail, you must resolve the failed items for each line.

Run and validate the sample tests with Teamcenter Easy Plan
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If you still do not get the correct validation results, contact Product Lifecycle Management Support
or your Teamcenter account team for assistance.

8. Click Close Validation Checks .

9. (Optional) Select the original object and run validation checks again to confirm that you have resolved
all failed tests.

When all validation checks pass, the assembly is ready for release.

Customizing manufacturing validation tests

Build customized manufacturing validation tests

After you verify that the sample validation tests provided with the installation are working, use these
instructions to build a new sample validation test library and verify that it works in your environment.

Note
You perform this task on the Teamcenter server where you installed the build components.

1. Open a Teamcenter command prompt.

2. Set the following environmental variables, if they are not already set.

Environmental variable Setting and comments

MSDEV_HOME Set to the local directory path for MS Visual
Studio. For example: c:\Program Files\Microsoft
Visual Studio 15.0\VC

TC_INCLUDE $TC_ROOT/include

TC_INCLUDE_CPP $TC_ROOT/include_cpp

TC_LIBRARY $TC_ROOT/lib

3. Execute the following command to compile
the validation sample code: compile_validations.bat
MfgValidationTestSuiteUtils.cxx MfgValidationTestSuiteA.cxx
MfgValidationTestSuiteAA.cxx MfgValidationTestSuiteAA_Tests.cxx
MfgValidationTestSuiteA_Tests.cxx.

4. Execute the following command to link the sample validation code: link_validations.bat.

5. Verify that you created the libmfgvalidationssamples.dll file, which is the sample validation library.

Customizing manufacturing validation tests
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Install and verify customized manufacturing validation tests

Now you can remove the validation test sample library, and replace it with the customized library that you
built.

Note
The Teamcenter developer performs this task.

1. Open a Teamcenter command prompt and change the directory to the validation samples directory.

2. Execute the following command: Run mfgValidationTestCallbackInstaller.bat <user>
remove.

Note
The .bat file is written so that <user>==<passwd>. Update the .bat file if this is not true.

3. Execute the following command: mfgValidationTestCallbackInstaller.bat <user>
create.

4. Use Teamcenter Easy Plan to run and validate sample tests in your environment.

Next, you can add customized validation tests to the library.

Add a new manufacturing validation test to the library

After you create customized manufacturing validation tests, you must add them to the library before end
users can run them.

Note
This procedure shows how to implement a test case that would fail any operation without an item
description.

1. Use a text editor such as Notepad++ to open the new test file, MfgValidationTestSuiteA_Tests.hxx.

2. Type the following text to add a new method to the test.

void operationHasDesc(tag_t lineTag);

3. Use a text editor such as Notepad++ to open the sample test file, MfgValidationTestSuiteA_Tests.cxx,
and search for the names section.

4. Type the following text to add a name to the test case.

static const std::string OperationHasDesc("Has Desc");

5. Search for the registration section of the file. For example, search for RegisterValidationTest.

6. Type the following text to register the new validation test.

Install and verify customized manufacturing validation tests
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registerValidationTest(OperationHasDesc_Test,
(generic_validation_test_callback_fn_type)&MfgValidationTestSuiteA_Tests::
operationHasDesc_Test);

7. Search for the ValidationSuiteTestNames section of the file, and type the following text to register the
new validation test.

validationSuiteTestNames.push_back(OperationHasDesc_Test);

8. Type the following text to implement the test case.

Add a new manufacturing validation test to the library
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9. Save the file, and close Notepad++.

Rebuild, install, and validate the validation tests library

Note
The Teamcenter administrator performs this task.

Perform this procedure before you release the customized tests into your production environment.

1. Build customized manufacturing validation tests.

2. Install and verify customized manufacturing validation tests.

3. Run and validate the customized test.

4. Verify that the test case contains customizations that you created. For example, this test case should:

• Contain a new column named Has Desc.

• Display a passed test for operations that have an item description.

Note
The Details panel displays an item description for the operation, if one exists.

• Displays a failed test for any operation that is without an item object description.

Tip
If you do not see the new validation test, review the procedure and perform the steps again. If you are
still unsuccessful, contact Product Lifecycle Management Support or your customer account team.

Add a new manufacturing validation test to the library
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11. Troubleshooting
Troubleshoot installation, configuration, and deployment

This section contains known installation, configuration, and deployment issues, and actions you can take
to resolve these issues.

Note
If these solutions do not resolve your issue, contact the Siemens Digital Industries Software Support
Center for additional help.

• Home page does not fully load.

• The Open with Study Manager command is not available in Manufacturing Process Planner .

• When trying to connect to Process Simulate or NX, an error message is displayed.

Troubleshoot installation, configuration, and deployment

Easy Plan 2412 ─ Deployment and Administration 11-1
Unpublished work. © 2024 Siemens Software Version Teamcenter 2412



Home page does not have a New Work Package tile

If end users log into a workspace and the Home page does not have a New Work Package tile, you can
run the following command to configure Teamcenter Easy Plan.

aws2_install_tilecollections -u=Tc-admin-user -pf=${TC_USER_PASSWD_FILE} 
-g=dba -mode=add -file=${TC_INSTALL_DIR}/mbc0mfgbvrcore/data/
Mbm0mbmGatewayTilesCots_Install.xml

For details about running scripts, see the Configuring Active Workspace help.

Home page does not fully load

If end users log into a workspace and the Home page does not fully load, or some tiles display a large X
instead of an icon, you need to initialize the Active Workspace command line environment.

You can run the following scripts to configure the command line variables you need to work in Active
Workspace, and initialize the environment.

For details about these scripts, see the Configuring Active Workspace help.

1. Open a Teamcenter command prompt

2. Run the initEnv.cmd script.

3. If you are on a Windows server, run the awbuild.cmd script, and close the command prompt window.

If you are on a Linux server, run the awbuild.sh script, and close the command prompt window.

Open with Study Manager command is unavailable

If the Open with Study Manager menu command is not listed in Manufacturing Process Planner (MPP),
you need to perform an additional configuration task.

See Add Teamcenter Manufacturing Access Study Manager to a rich client for details.

Note
This problem occurs only when you add Teamcenter Manufacturing Access Study Manager to a four-tier
Teamcenter rich client.

Home page does not have a New Work Package tile
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When trying to connect to Process Simulate or NX, an error message is
displayed

If this error message is displayed and end users cannot connect to Process Simulate or NX, you need to
perform an additional configuration task.

Set the hosting preference to connect to Process Simulate and NX

To connect to Study Manager (Teamcenter Manufacturing Access) from Process Simulate and NX, you must
configure the TCMAHosting.PS.URL preference.
The format for this preference is http://<serverhost>:<gatewayport>.

When trying to connect to Process Simulate or NX, an error message is displayed
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When trying to connect to Process Simulate or NX, an error message is displayed
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12. Reference
Full features list for an installation on Active Workspace

The following table contains features you can select during an installation on Active Workspace.

To install this workspace or
component Select this feature

Electronic Work Instructions Client Electronic Work Instructions

Electronic Work Instructions Change
Management

Electronic Work Instructions—Change Management

This feature adds support for Change Management in
Electronic Work Instructions.

Note
This feature requires corresponding Teamcenter Change
Management features.

Electronic Work Instructions Execution Electronic Work Instructions—Execution

This feature adds support to

• Capture shop floor data

• Require or allow personnel to record and edit serial and lot
numbers

• Record work in progress

• Allow personnel to attach documents

Electronic Work Instructions
Visualization Server Manager

Electronic Work Instructions—Visualization Server Manager
(VIS-HOST)

This feature supports 3D visualization for snapshots in
Electronic Work Instructions.

Teamcenter Easy Plan-Process Planning
for BTO/BTS/CTO

Easy Plan-Electronics Process Planner

Full features list for an installation on Active Workspace
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Note
(Optional) Install this feature to integrate with Valor
Electronics Manufacturing Solutions software.

Easy Plan-Process Planning for BTO/BTS/CTO

Teamcenter Easy Plan-Product Configurator (optional)

Select Easy Plan—Product Configurator to support Product
Configurator in your environment. Product Configurator
allows you to enable definitions for variant formulas
on operations. Please see the Product Configurator
(Administrator) documentation for installation details.

To use Product Configurator variants, you must be in
Teamcenter 11.5 or later.

Manufacturing-BOM Manager Manufacturing-BOM Manager

Next Generation Planning Next Generation Planning Client

Teamcenter Manufacturing Access Teamcenter Manufacturing Access

Teamcenter Easy Plan-Process Planning
for ETO

Process planning and work instructions authoring for ETO

Caution
Verify that you select the following features during Process Planning for BTO/BTS/CTO and Electronic
Work Instructions installations.

Active Workspace client features

• Change management

• Product configurator → Change management

Client/server features

• Active collaboration

• Active content

• Classification

• Process Planning for BTO/BTS/CTO → Product configurator client
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• Workflow

Enterprise knowledge foundation

• Change management

Extensions

• Product configurator

Server extensions

• Product configurator

Database templates summary

The following table lists the templates that are installed in the database with each workspace during
installation.

Workspace Templates

Electronic Work Instructions • Active Content Structure
(activeworkspacebom_template.xml)

• Active Workspace Document Management
(dma1docmgmtaw_template.xml)

• Manufacturing Characteristics Information
(mci0mfgcharacteristics_template.xml)

• MRO Core (Mrocore_template.xml)

• Visualization Extension for Active Workspace
(awv0activeworkspacevis_template.xml)

• Work Instructions (cmtmes_template.xml).

Manufacturing-BOM Manager • Active Content Structure
(activeworkspacebom_template.xml)

Easy Plan 2412 ─ Deployment and Administration 12-3
Unpublished work. © 2024 Siemens Software Version Teamcenter 2412



• Core services for manufacturing on BVR
(mbc0mfgbvrcore_template.xml)

Next Generation Planning • 4th Generation Process Planning/Data Model
(cmtprocess_template.xml).

• 4th Generation Process Planning/Data Model
(ngp0ngpclient_template.xml).

• Manufacturing 4G Core/Data Model
(mac0mfgapscore_template.xml).

• Manufacturing Change Management/Data Model
(mpc0mprcm_template.xml).

Process Planning for BTO/BTS/CTO • Manufacturing core for BVR/Data Model
(mbc0mfgbvrcore_template.xml)

• Process Planning for BTO/BTS/CTO Change Management/
Data Model (epc0mfgbvrmaturity_template.xml)

• Process Planning for BTO/BTS/CTO Line Balancing/Data
Model (elb0linebalancing_template.xml)

• Process Planning for BTO/BTS/CTO Time Analysis/Data Model
(ept0timeanalysis_template.xml)

Teamcenter Manufacturing Access • Teamcenter Manufacturing Access/Data Model
(tca0tcmaccess_template.xml).

Teamcenter Easy Plan - Process Planning
for ETO

• Manufacturing core for BVR/Data Model
(mbc0mfgbvrcore_template.xml)

• Process Planning for BTO/BTS/CTO Change Management/
Data Model (epc0mfgbvrmaturity_template.xml)

• Process Planning for BTO/BTS/CTO Time Analysis/Data Model
(ept0timeanalysis_template.xml)
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